ﬁ July, 2014

[ADPLL]

Faculty Of Engineering ,Cairo University







LOW POWER, SMALL AREA
ALL DIGITAL PHASE
LOCKED LOOP (ADPLL)

By
Ammar Mohammad Ibrahim

Ammar Mohammad Hussein

Mohammad Abdel-Lateef Abdel-Tawab

A thesis submitted in partial fulfillment of
the requirements for the degree of

Bachelor of Science in Electronics and
Electrical Communications Department,
Faculty of Engineering

Cairo University

Supervised by
Dr. Hassan Mostafa

July, 2014






ABSTRACT
ADPLL

The objective of the thesis is to design an All Digital Phase Locked Loop (ADPLL)
with low power. The design consists of three main blocks: Digitally Controlled
Oscillator (DCO), Phase Detector (PD) and Loop Filter (LF). The DCO is considered
as the heart of the ADPLL as it consumes the most power for the whole system. The
design went through two different approaches, standard cells and custom cells .This

design can be used in Clock and Data Recovery (CDR) system as an application.

This thesis presents a low power all digital phase locked loop (ADPLL) in 65 nm
CMOS process with 1.2 V power supply. It operates in the frequency range of 100 —
300 MHz. The ADPLL uses a digitally controlled oscillator with two stages, fine
tuning stage and coarse tuning stage. The source of oscillation for this DCO is the ring

oscillatot.

The proposed ADPLL uses also a phase-frequency detector (PFD) and shift registers
for the loop filter. It achieved power consumption at 200 MHz of 0.6 mW and a lock

time of 1 uS.

The last design step of the ADPLL is the layout, some modification applied to the
layout to satisfy the required specifications, at the end of this thesis a comparison

between the required and the achieved specifications in schematic and layout level.

Design considerations of the ADPLL circuit components and implementation using
Cadence, Synopsys and Mentor tools are presented; the AMS tool is used frequently in

the standard cells flow.
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Chapter 1

INTRODUCTION

The PLL represents one of the most active topics in signal processing and
communication theory. The initial ideas started as early as 1919 in the context

of synchronization of oscillators. The theory of phase-locked loop was based

on the theory of feedback amplifiers. The PLL contributed significantly to
communications and motor servo systems. Due to the rapid development of
integrated circuits (IC’s) since the 1970’s, PLLLs are widely used in modern signal
processing and communication systems, and it is expected that PLL will
contribute to improvement in performance and reliability of future
communication systems. The applications of PLLs include filtering, frequency
synthesis, motor speed control, frequency modulation, demodulation, signal
detection, frequency tracking and many other applications.

The PLL consists of three main blocks VCO, Loop Filter and Phase detector as

shown in figure 1.1.

vi(t)
—_— v (1) V()
Phase Detector Loop Filter >
V(1) Voltgae
Controlled <
Oscillator

Figure 1.1: Block diagram of the PLL



There are many types of PLL according to the internal blocks and designing
techniques as following:

1. LPLL: Linear Phase LLocked Loop which contains a VCO and RC circuit
for the Loop Filter block and uses a multiplier to detect the phase
difference between the reference frequency and the VCO output
frequency.

2. DPLL: Digital Phase Locked Loop was the very first digital PLL; it was in
effect a hybrid device ONLY the phase detector was built as a digital
block like EXOR.

3. ADPLL: All Digital Phase Locked Loop in which all the blocks are built

as digital blocks.

ADPLL consists of the same three main blocks mentioned previously except for

the VCO; it will be replaced by the DCO as shown in figure 1.2

Ref Freq

— “— Loop [
PED Lo | pilter s

DCO_Out

DCO

Figure 1.2: The Overall block diagram of the
ADPLL



PLL in general has its own parameters such as:

e The operating frequency range: the range of frequencies that PLL can
lock on them.

e 'The lock time: the time which PLL needs to lock on the reference
frequency.

e The Jitter: undesired deviation from the true periodicity of an assumed
periodic signal.

What is Jitter?

Jitter is the undesired deviation from true periodicity of an assumed periodic
signal, Deviation (expressed in T ps) can occur on either the leading edge or the
trailing edge of a signal. Jitter may be induced and coupled onto a clock signal
from several different sources and is not uniform over all frequencies.

Period of ring oscillator vibrates in a random manner T=T+T" where T" is a
random value. In high-quality circuits range of T" is relatively small compared to
T. This variation in oscillator period is called jitter. Local temperature effects
cause the period of a ring oscillator to wander above and below the long-term
average period when the local silicon is cold, the propagation delay is slightly
shorter, causing the ring oscillator to run at a slightly higher frequency, which
eventually raises the local temperature. When the local silicon is hot, the
propagation delay is slightly longer, causing the ring oscillator to run at a slightly

lower frequency, which eventually lowers the local temperature.

Unit interval Jitter Amplitude
-—
- -
Ideal signal < Jittered signal

Jitter Frequency

Figure 1.3: Jitter Illustration
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We considered the DCO as the first design stage, because it consumes about
50% of the system power and covers the most area of the whole system area. The
design went through two approaches the custom cells and the standard cells. The
DCO is done in the custom approach however; the rest of the design went
through both approaches.

The proposed ADPLL has the following specifications:
e Power <1mW.
o Area<0.01 mm?.
e Frequency Range from 100 MHz to 300 MHz.
e Lock time < 10 us.
e DPeak to Peak Jitter < 20 ps.
e R.MS. Jitter <5 ps.

In the following chapters we are going to discuss the design steps in details for

each block of the ADPLL to satisfy these requirements.

Frequently Asked Question about ADPLL:

= Why digital? What is the problem of the analog (linear) one?
e Basically, the ADPLL consumes less power than the linear PLL.
e ADPLL can be easily scaled down to another technology.

e Linear PLL needs an off chip components such as capacitors and
resistors (for the loop filter) which do not have a fixed and stable

value because they may suffer from aging.

e ADPLL covers less area than linear PLIL..



Chapter 2

CUSTOM CELLS APPROACH

2.1 Digitally Controlled Oscillator

The digitally controlled oscillator (DCO) is considered the heart of the PLL as it
controls the overall system performance and consumes the most power and area
of the whole design. The proposed DCO follows a full custom design approach

to make it easier to control its area and power. It consists of three main blocks:
1. A ring oscillator
2. A fine tuning stage (DCV Array)
3. A Coarse tuning stage (DCV2 Array)

Figure 2.1 is the symbol view of the DCO.

[A\‘-, P q DCO_Out

Figure 2.1: DCO symbol view

Another figure for the internal block diagram of the DCO is figure 2.2, figuring

out its three main blocks.



VDD

Voo p—————
A e DCO_Out |—=—J DCO_Out

VDD
= 1
Cc2
C3
c4
Cc5
Ccé
VDD
CL1
L2
CL3
%=

346

Qo Ny
F<15:0> [Pom— F<15:0> dev_arra = ‘a’ Uzo
; ’ v-EmEE C<15:0> [Prmmmm—| C<15:0> 9V
° 1328
& 2
o
: +
=
o o
-
o

Figure 2.2: DCO internal structure

We will start our discussion by investigating the internal structure of the ring
oscillator followed by the fine tuning stage (DCV Array) and finally the coarse
tuning stage (DCV2 Array).

2.1.1 Ring Oscillator

The ring oscillator is the source of oscillation for the DCO. It consists of an odd
number of inverters in a cascaded configuration with a feedback from the output

to the input. Figure 2.3 is a block diagram for the proposed ring oscillator.

Figure 2.3: Ring oscillator block diagram



The design of the ring oscillator follows a full custom approach. The following is

the schematic view (figure 2.4) of the basic cell for the ring oscillator, the inverter.

f\‘ w=240.0n

60N

.O ut

nch M@
.—{ W= 1 20.0n
T 6on

GND

Figure 2.4: A Schematic view for the inverter

The simulation result for the inverter can be found in figure 2.5.
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Figure 2.5: Simulation results of the inverter

Next step is to simulate the ring oscillator as cascaded inverters without any delay

cells. Simulation result for this step is shown in figure 2.6.

Transient Response

754

vy
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Figure 2.6: Simulation results for the ring oscillator
without delay cells



The problem with the simulation results of this ring oscillator is that, the output
frequency is in range of GHZ (Period = 144.5 ps) not MHZ and our lock range
is from 100 MHZ to 300 MHZ. To solve this problem, we added delay cells to
the internal nodes of the ring oscillator. The delay cells to be added to the ring
oscillator are Hysteresis Delay Cells (HDC). Each HDC cell consists of two cross
coupled inverters. The schematic view of the HDC cell can be found in the figure
2.7.

VDD

vDD

in
\ /

Figure 2.7: A schematic view of the HDC

The schematic view of the ring oscillator with HDC cells attached to it, is in

figure 2.8.



GND d ¢

The simulation result for this modified ring oscillator is in figure 2.9 and it

GND
—n
GND
2\
(015]

Figure 2.8: The ring oscillator with HDC cells

increased the period of oscillation from 144.5 ps to 678.3 ps.
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Figure 2.9: Simulation results for the ring oscillator
with HDC cells
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2.1.2 A fine tuning stage (DCV Array)

For the proposed DCO, we use a fine tuning stage to give a step change in the
period of oscillation of about 48 ps. The DCV cell is a NAND based delay cell. A
schematic view of this DCV cell can be found in figure 2.10.

VDD

P(_|- M2 M3 p(_h

GND
Figure 2.10: A schematic view for the DCV cell

The idea of operation of this cell is that, the gate capacitance seen from node CL
(It refers to the load capacitance and it is connected to the output node of each
inverter in the ring oscillator) can be changed according to the gate voltage

applied to the node D (it refers to digital input bit of the DCO). The formula of

11



the resulting gate capacitance for this NAND based cell in both cases (when D is

high and when it is low) is as follows in figure 2.11:

C ! Cyn*Cry Yo "
Agate 0\~ ALN C,,‘_;_.\’ & C‘/'"\’ ALP

A

+P(Cun+Cpn)+Cyp+Cypp
Cap.p”
()

B

Crn=Cun+Cphy+Cpy

(b)
(¢)

Figure 2.11: The gate capacitance
of NAND gate

Where p0 is probability second input (B) to be equal the ZERO and p1 is
probability second input to be equal the ONE (p0 + p1 = 1). The simulation
result in figure 2.12 illustrates changing the gate capacitance with the gate voltage
(CL) in two cases, when D is high and when it is low. From this result, it seems
that we can achieve high capacitance for the case when the digital input bit is high
(D=1) and we can get a low capacitance when it is low (D=0). Increasing the load
capacitance for each node of the ring oscillator output means increasing the delay
as the value of RC constant will be increased. For the ring oscillator and for a
typical inverter, the propagation delay can be calculated from the following

formula:

Reqp 2 5 Reqn
2
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Where CL is the output capacitance of the inverters of ring oscillator which is the
gate capacitance of the delay cells. Reqp and Reqn are the equivalent resistances

of the PMOS and NMOS transistors respectively.

™ oo

Gate capacitance [fF]

0 | 1 1 1 1 1
0.000 0.500 1.000 1.500 2.000 2.500 3.000

Gate voltage [ V]

Figure 2.12: Simulation results for the NAND
based DCV Cell

We use this NAND based DCV cell as a building element for a DCV block in
the fine tuning stage. Every twelve DCV cells are connected to a single input
which is the digital input bit (D). The output of this block consists of six nodes
from C1 to C6. These nodes are connected to the corresponding outputs of six

inverters in the ring oscillator. A block diagram for the DCV block is in figure
2.13.

N ——————
Vo0 @————
o @—
o
C@—— o
- —
R S—
s @
>

Figure 2.13: A block diagram for the DCV building
block
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We then use this DCV block to construct the DCV array consisting of sixteen
DCV blocks. All outputs of the sixteen blocks (C1 to C6) are connected to the
same six nodes of the ring oscillator but each input from the DCV blocks is
connected to a different external digital bit so, for the DCV array of the fine
tuning stage we have a digital word of sixteen bits. Figure 2.14 is the internal

structure of the DCV array:

A E“:\van
b Slelolold|o ]S
0
\Y
L
aQmaNMN SN ©
OLOLOOOO
>
<@>
D dcv_block
o [329
oND @p———— @ "
voo @p———
c
(o)
Z
Ty — G
o
S — (s
SlelSBI3I8]8
G
36.—
O NS 0N
o 20 0000

& D dev_block
1331

GND
—&—— GND

Figure 2.14: DCV array internal structure

A symbol view of this DCV array is shown below in figure 2.15:

14



}m Lﬂ

©lo
[346

(o]

O

800333
=>
F<15:0> [|Hun— F<15:0> dcv_array
(]
=
O
0O
=z
(633

Figure 2.15: A symbol view for the DCV array

An important thing to notice here is that, although we achieved a fixed step in
period of about 48ps for fine stage, the step in output frequency is not fixed
because the relation between the frequency and period is not linear. For the same
period step we get many frequency steps depending on the location of this period
step in time access. For example, our DCO period range is from 3.3 ns to 10 ns
consider adding a period step to the first period in range, from 3.3 ns to 3.348 ns
(3.3ns+48ps), 3.3 ns corresponds to a frequency of 303 MHZ and 3.348 ns
corresponds to a frequency of 298.686 MHZ so a period step of 48 ps from 3.3
ns to 3.348 ns causes a frequency step of 4.314 MHZ. Let’s consider the same
period step added to another period in another location in time access, for the
last period of output oscillation from the DCO which is 10 ns, the period before
this one is 9.952 ns (10 ns — 48 ps), 9.952 ns corresponds to a frequency of
100.482 MHZ and 10 ns corresponds to a frequency of 100 MHZ, so the same
petiod step of 48 ps when added to the period 9.952 ns we get a frequency step
of 0.482 MHZ. For these two cases we get two different frequency steps of 4.314
MHZ and 0.482 MHZ although the period step of fine stage is constant.
Conclusion is that, although the period step for fine stage is constant we will get

different frequency steps (not fixed) because the relation between frequency and

15



period is not linear. Figure 2.16 illustrates why we get different frequency steps

for the same period step.

%10
ER T T T T

Frequency (HZ)

Period (Sec)

Figure 2.16: Period step Vs. frequency steps

2.1.3 A coarse tuning stage (DCV2 Array)

After using the fine tuning DCV array we achieved a relatively small step change
in output period of the DCO and consequently a relatively small frequency steps.
For the coarse stage we need to get larger frequency steps to reduce the lock time
of the PLL, to achieve these larger frequency steps we have to use delay cells with
larger period steps than the fine tuning stage (48 ps), so we used another delay
cell to get this larger period step. The delay cell used for coarse tuning stage is
also based on the NAND configuration but with a transmission gate in the
beginning. The enable line for this transmission gate is the external digital input
bit (D) and the input to it is the load capacitance node (CL) which is connected
to the output of each inverter in the ring oscillator. Figure 2.17 is a schematic

view for this delay cell.
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GND

GND

Figure 2.17: A schematic view for the DCV2 cell

When the external input is low (D=0), the CL node will be disconnected from
the NAND cell and introduces low capacitance and consequently low delay.
When the external input is high (D=1), the CL node is now connected to the
NAND cell and can see the gate capacitance of it. The two cases of D=0 and
D=1 here are different from those in fine tuning stage, as in fine tuning stage the
CL node was connected to NAND cell in both cases that’s why the period step in
fine stage was relatively small. In coarse stage, the CL node is connected only
when D=1 so we can say that, in coarse stage the node CL can see the
capacitance of the NAND cell or it cannot see it, so the period step here is larger
than the period step in fine stage. For coarse stage we achieved a period step of
380 ps. Another advantage for using the DCV2 cell is that, it helped us increase
the largest output period of the DCO (10 ns) without affecting the smallest
period (3.3 ns) by changing the sizing of the NAND cell in this DCV2 cell

We use this NAND based DCV2 cell as a building element for a DCV2 block in

the coarse tuning stage. Every eight DCV2 cells are connected to a single input

17



which is the digital input bit (D). The output of this block consists of four nodes
from CL1 to CL4. These nodes are connected to the corresponding outputs of
four inverters in the ring oscillator. These four inverters are following the six
inverters used in the fine stage. A block diagram for the DCV2 block is in figure
2.18.

o ) [=]
o (=)
VDD .—VDD >é >é
D VDD
GND D VoD [ &
oNo @——— =S =_c
oL @—E GfD LE
o o
C z
cL2 .—LZ D_“ o & % [
-
cL3 o o 4
o @—2 g g
cL4 Z B
cL— D vBors 0 VOD
b =
D - € GND .
o GTD T
o 2
z &

Figure 2.18: DCV2 block

We then use this DCV2 block to construct the DCV2 array consisting of sixteen
DCV2 blocks. All outputs of the sixteen blocks (CL1 to CIL4) are connected to
the same four nodes of the ring oscillator but each input DCV2 blocks is
connected to a different external digital bit so, for the DCV2 array of the coarse
tuning stage we have a digital word of sixteen bits. The following figure is the

internal structure of the DCV2 array (Figure 2.20).
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A symbol view of this DCV2 array is shown in figure 2.20.
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Figure 2.19: DCV2 array
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Figure 2.20: A symbol view for the DCV2 array

2.1.4 Conclusion and final results

In this section we introduced the proposed DCO which is consisting of three

main blocks:
1. A ring oscillator
2. A fine tuning stage
3. A coarse tuning stage

The output period for this DCO ranges from 3.3 ns to 10 ns which is equivalent
to a lock range from 100 MHZ to 300 MHZ. We used HDC cells to add a fixed
delay to the ring oscillator and DCV cells for both fine and coarse tuning stages
to add a programmable delay. The fine tuning stage gives a small step (48 ps) in
period and consequently small steps in frequency. The coarse tuning stage gives

large period step (380 ps) and consequently large steps in output frequency.
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The following table in figure 2.21 shows different output periods of the DCO
according to different values for the digital words of both fine and coarse tuning

stages.

Control bits Period Frequency Periodstep Freq.step

Fine Word Coarse Word

00000000 00000000 00000000 00000001 3.669 272.553 0.38 32.325

10000000 00000000 00000000 00000011 a1 243,902 0.382 25.059

11000000 00000000 00000000 000001 11 4.53 220.75 0.383 20.388

11100000 00000000 00000000 00001111 4.961 201.572 0.383 16.863

11110000 00000000 00000000 00011111 5.38973 185.538 0.38073 14.103

11111000 00000000 00000000 00111111 5.82148 171.778 0.38453 12.149

11111100 00000000 0000000001111111 6.25404 159.897 0.38504 10.49

11111110 00000000 00000000 11111111 6.68375 149.617 0.38518 9.149

11111111 00000000 00000001 11111111 7.1095 140.657 0.464 7.906

11111111 10000000 00000011 11111111 75419 132.593 0.3812 7.058

11111111 11000000 00000111 11111111 7.9758 125.379 0.38205 6.308

11111111 11100000 00001111 11111111 B.41188 118.879 0.38708 5.735

11111111 11110000 00011111 11111111 8.84562 113.05 0.38732 5177

1111111111111000 0011111111111111 9.2775 107.788 0.3857 4675

11111111 11111100 0111111111111111 9.7117 102.969 0.3858 4.259

11111111 11111110 11111111 11111111 10.146 98.561 0.3855 3.893

Figure 2.21: Different output periods of the DCO

The simulation result in figure 2.22 is different output waveforms for the DCO.
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Figure 2.22: Different output waveforms of the
DCO

Figure 2.23 is the period steps versus the digital code according to the above

table, one coarse step change followed by one fine step change. From this figure,

one can easily notice the coarse step is larger than the fine step. The start point of

our range is 3.3 ns and the end point is 10 ns corresponds to the lock range for

the proposed DCO (100 MHZ to 300 MHZ).

Period (ns)

30 35

Code

Figure 2.23: Period steps versus code

Figure 2.24 is the output frequency versus the 32-bit digital input word (16-bit

word for fine stage and 16-bit word for coarse stage).
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Figure 2.24: Frequency steps versus code
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2.2 PFD

A phase detector is a circuit capable of delivering an output signal that is proportional to
the phase difference between its two input signals Ref_Freq and DCO_Out as mentioned
in figure 1.2. When the PLL moved into digital territory, digital phase detectors become
popular, such as EXOR gate, the edge-triggered JK-flip flop, and the so-called phase-
frequency detector (PFD).The PFD differs greatly from the other phase detector types as
its name implies, its output signal depends not only on phase error but also on frequency
error when the PLL has not yet acquired lock. The PFD is built from two D-flip flops,
whose outputs are denoted UP and DOWN(DN) as shown in figure 2.25, these two
signals are the digital representation of the phase/frequency error. The PFD can be in

one of four states:

VDD VDD
= UP=0, DN=0 g
Rst UP
—&—D Pre Q —=—
= UP=1, DN=0 Pos_Edge_DFF
Ref_Freq
CLK RST Q_Bar 88—
= UP=0, DN=1
= UP=1, DN=1
PFD_Rst
The fourth state is inhibited, however, by an
additional gate. Whenever both flip flops are in
DCO_Out RST
the 1 state, a logic low level appears at their reset — & |CLK Q_Bar —@——
Pos_Edge_DFF
inputs, which reset both flip flops. We assign the _Bet o lp Pre Q |—LOMN
symbols -1, 0, and 1 to these three states : % i
= UP=0, DN=0 - state -1 gl 8
> >

Figure 2.25: PFD schematic
» UP=1,DN=0 - state 0 &

= UP=0,DN=1 -> state 1

The actual state of the PFD is determined by the positive-going transients of the
signals Ref_Freq and DCO_Out, as explained by the state diagram in figure 2.20, a
positive transition of Ref_Frq forced the PFD to go into its next higher state,
unless it is already in the 1 state. In analogy, a positive edge of DCO_Out forces

the PFD into its next lower state, unless it is already in the -1 state.
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Figure 2.26: State diagram of the PFD

To see how the PFD works in a real PLL system, we consider the waveforms in

tigure 2.27,this figure shows the three cases:

a) First 25ns shows the case where Ref_Freq leads, therefore the PFD toggles
between states 0 and 1.

b) If Ref_Freq lags as in the next 25ns, the PFD now toggles between states
-1 and 0.

¢) The signals Ref_Freq and DCO_Out are ‘exactly’ in phase; both positive

edges occur at the same time; hence the PFD will stay in state 0 forever.

125{RefFreq e —_— —_—
|
10 & aw | [ B
& A\
> 5 \
254
oo
T 1 1 TS T 1T o]
/ 2ns 4ns
8333- \ { /1N
2 4167
15{0P1
M
e
>
-2%
15/DOWRL
s l ‘— J——U H J
>
=25

0 94 19 28 38 47 56 66 5
time (ns)

Figure 2.27: PFD simulation results
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2.3 Loop Filter:

The Loop filter stage controls the output capacitance by changing the number of
DCV cells that are turned on, as shown in figure 2.28 the digital control signals is
used to increase/dectrease the DCO frequency for a certain period of time by
reducing /increasing the capacitance. If the input to the DCV is ‘1’, it provides
more capacitive load at the output. If more number of cells are on (input is ‘1°),
then it acts as more capacitive load on the ring oscillator which reduces the DCO

frequency.

11{0[{0]0[{0]0[0]...[0]0[0 [0[*T0

| L
|

|
Il J
L ..il-_l Cine
N N 0

i

I—II—-‘_l

b
—r

|
I
L.
T1

I
L
I

Figure 2.28: digital control signals used to switch a set of varactors

In order to control each of the fine DCV array and the coarse DCV array
individually, we have used two 16-bits bi-directional loadable shift registers and

here part of the schematic view for each shift register in figure 2.29
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Figure 2.29: Schematic view of the shift register

Initially, 8 DCV cells of each array are on, this achieved by using asynchronous
Reset and Preset signals. Depending on the up/down signals from PFD, the
frequency is either increased or decreased. When phase and frequency
acquisition starts, if the output of PFD is up, then the contents of the shift
register are left shifted and bit ‘0’ is pushed into Q<15> and hence the
capacitive load decreases and the frequency increases. Likewise, if it is down,
the contents of the shift register are right shifted and bit ‘1’ is pushed into
Q<0>. This reduces the frequency of the DCO as the capacitive loading at the

output increases.
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2.4 Overall Design
In this section the simulation results of the whole system will be introduced.
2.4.1 Extreme Reference frequency

First let the input (reference frequency) signal be an extreme, let’s say the minimum

frequency in the desired range (100-300MHz) as in figure 2.30.And by knowing

200.0

175.0

frequency (MHz)
S
ol
°

—_
~
]
(=]

100.0 _MO(31.81ns, 97.92MHz)
M1(5.404ns, 83.33MHz)
75.0 T T r v
0 10 20 30 40 50
25.02ns| 83.3333MHz time (ns)

Figure 2.30: Reference = 100MHz

that the DCO frequency initially equals to the center frequency (200MHz), then the
shift register should get only DOWN pulses from the PFD, which activates all the
DCV cells and introduces the lowest frequency .now what about the lock time ?
Actually this depends on two factors, the:
i CLK used for the loop filter: this means the rate of changing in DCO
frequency at a certain time. It’s clear that we need to increase the frequency

of this CLK to get smaller lock time.

i.  DCO Delay : this means time needed by the DCO to change its frequency
after one step delay as shown in figure 2.31, where one DCV cell is
deactivated after two cycles, the effect of this step appears after exactly two
cycles, this time is considered as the DCO delay, thus the CLK above in part
(1) should take in consideration this delay to get the true UP/DN pulse
after the new change in the DCO frequency.
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Figure 2.31: DCO delay

2.4.2 Intermediate Reference frequency

Now let’s consider this case, reference = 250MHz as below in figure 2.32.

325.0

verage Frequency=249.8MHz
299.04

|
TV

(213MHz)

(297.1MHz)

N
~
w
o

frequency (MHz)
N
N
o

221.04

195.0;

98.0 196.0 294.0 392.0 490.
time (ns)

Figure 2.32: Reference= 250MHz

It’s clear that average frequency is almost equals to the reference, but the problem that
appears here due to the wide steps of the course stage (up to 31MHz), which results to
these oscillations with a very high peak-to-peak value. Simply to solve this problem, the
coarse stage must be stopped after being operating separately from the fine stage. This is
applied using a 4bit Counter to count the maximum number of steps needed by the
coarse stage, which is 16 at the worst case, after that a carry signal is used to turn off the

coarse shift register and activates the fine one. The simulation results of this idea are



shown in figures 2.33a, 2.33b and 2.33c.
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Figure 2.33: Effect of using counter
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In this example the reset signal of the whole system was designed to start the DCO
oscillations at the center frequency, this is achieved by activating four DCV cells
from each array, to calculate this frequency as explained in section 2.1 :

Period (ps) = 3270 + Coarse_1’s X (380) + Fine_1’s X (48) = 5ns (200MHz).
Through the first stage the fine SR is stopped as shown in figure 2.33a and 2.33c,
and at the end of this stage the DCO frequency was undecided between two
frequencies around the reference corresponding to the digital words which clarified
in figure 2.33c, after that the course stage stopped using the carry signal at 38n as
shown in figure 2.33a.At the same time the fine stage started, this can be observed
through the frequency response in figure 2.33b ,where the very small slopes appears
after the 38ns.

2.4.3 Frequency step response

It was necessary to consider in our design that the Reference signal frequency may
be changed during the loop, because this PLL targets a low power clock and data
recovery system. But in order to detect this change, the loop filter won't be a simple
shift registers as it now because a certain controlling circuit must be added. Actually
we have replaced the coarse SH by a frequency counter circuit which is one of
Digital Instruments that can be used to measure signal frequency and period, the

basic idea is illustrated in the following figure:

mput | L/ LI LI
Gate ___lq t P

output | LI L/ LI LI L_ N pulses

Figure 2.34: Frequency counter

We have implemented this idea by generating the Gate signal (figure 2.34) from the
reference frequency, and the input clock source (time base) signal which used to

trigger the counter from a ring oscillator which already discussed in section 2.1.1.
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After counting the N pulses mentioned in figure 2.34, this number is therefore
mapped to the 16 bit to control the coarse DCV array. Note that at the end of each
counting period, the counted value should mapped synchronously and the counter
should cleared. In the following the whole system simulation result after using the

frequency counter :

350

300

250

200

frequency (MHz)

1004

50.0

time (us)

Figure 2.35: frequency step response

After this modification on the system to become capable of reacting with the step
system response, the consumed power is increased from 0.25 to 0.6 mWatt due
to the high frequency clock added. Also the lock time at the worst case does not
exceed 300ns. Now there is one more enhancement needed

The last improvement needed, is to reduce the oscillation of the fine stage around
the reference, this is achieved by slowing its clock frequency. Figure 2.36 shows the

result after this modification.
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Figure 2.36: Eliminating the oscillations
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As expected, slowing the fine SR led to the expansion of the time lock until the

time of lus as figure 2.36 shows.

2.4.4 Jitter calculation :
Figure 2.37 shows the eye-diagram of DCO output clock when locked at 300 MHz
plotted using Cadence tools. In this eye-diagram, each and every cycle of
the DCO output clock are overlapped on one clock period (after the DCO clock is
locked to the reference) and the maximum deviation that can be obtained from the
graph is measured as peak-to-peak jitter. Number of cycles that are taken into
account are 100. The delay is measured at 50% voltage levels and the period jitter

determines how noisy and stable the oscillator output signal is.

— eyeDiagram( DCO_Out )

| peak to peak jitter = 35 ps

V)

time (ns)

Figure 2.37: Eye-diagram of the ADPLL

The peak-to-peak jitter for this implementation when the feedback signal is

locked at 300 MHz is 35 ps.

33






Chapter 3

STANDARD CELLS APPROACH

Standard Cells Approach means that the targeted block will be written with one
of the Hardware Description Language HDL codes such as Verilog or VHDL,
and then can be translated into an hardware circuit using Standard Cells library.
Thanks to AMS we are able to simulate and test the targeted block with analog

blocks in cadence environment.

One big advantage of using such approach is that the designer is not have to deal
with the block gates at the transistor level and check the sizing of the logic gates .

This approach also made the layout step very easy and effective in area.

3.1PFD

As mentioned before, the Phase and Frequency Detector (PFD) will be used as a
phase detector to detect the phase and the frequency difference between the

reference signal and the output signal of the DCO.

First of all, we will write the code of our PFD using Verilog programming

language , we will design a block which has:

= Two input ports (reference signal and DCO output).

* Two output ports (Up and Down).

The Up signal indicates that the system should increase the DCO frequency (i.e.
the reference frequency is higher than the DCO frequency) and the Down signal
indicates that the system should decrease the DCO frequency.
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module dff (input d,clk,reset,output reg q);
always@(posedge clk,negedge reset)
if(~reset)

q<=1'b0;

else

g<=d;

endmodule

module pfd (input refSignal,dcoSignal,output up,dn);
wire intReset;

assign intReset=~(up&dn);

dff up_dff(1'b1,refSignal,intReset,up);

dff dn_dff(1'b1,dcoSignal,intReset,dn);

endmodule

And using Synplify PRO we translated our PFD into the corresponding standard

cells schematic as shown in figure 3.1

o

1
—
d
[refSignal clk ( | > > S o
reset
reset

un)1_intReset intReset dn_dff

[acoSignal

Figure 3.1: PFD schematic

This PFD can be imported as Verilog code in cadence also , see appendix A for

more details.
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3.2 Loop Filter

The Loop Filter used here is simply a 16 bits shift register ,following the same

procedure of PFD ,we got the schematic view of the Loop Filter as shown in

figure 3.2.

module loopFilter ( input up,dn,reset, output reg [15:0] q);
wire ored;

assign ored = up | dn;

always @(posedge ored, negedge reset)
if(~reset) //active low reset(level sensitive)
g<= 16'b11110000_00000000;

else if(up & ~dn)

g <= {q[14:0],1'b0};

else if(dn & ~up)

g <= {1'b1,q[15:1]};

endmodule

uni_dn R 20 150] Q[15:0) s orrmor——

= 1 4[15:0]

q[15:0]

un1_up un1_dn_1

[reset *Jl>0‘

qi7

Figure 3.2: Loop Filter schematic
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We used two Loop Filters, one as a Coarse and the other as a fine, the Coarse
one is responsible for the large step change in the DCO output frequency while

the fine one is responsible for the small step change.

3.3 PFD and Loop Filter

Now, we have PFD and Loop Filter as functional blocks, so we can connect

them together as shown in figure 3.3.

pfd loopFilter
refSignal up —e——=— up
dcoSignal  dn dn q[15:0] 15,0]15:0
—e— reset
pfd_device

loopF_coarse

loopFilter
up

15:0
dn q[15:0] 150 o_fine[15:0] =

[reset reset

loopF_fine

Figure 3.3: PFD and Loop Filter

Now , we have our functional block (PFD + Loop Filter) so we can import it to

cadence environment and connect it with the custom designed DCO.
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3.4 Overall Design
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Figure 3.4: Overall ADPLL (standard cells)

Using AMS we can simulate analog and digital(functional) blocks together and

check the functionality of our ADPLL and the result was as shown in figure 3.5

— (freq ¥T("fnet5") "falling" ?xName "time" 7mode "auto” Zthreshold 0.0) — (freq ¥T("/net2") "falling" %Name "time” mode "auto” 7threshold 0.0)
325.0;

L YA A AL
iy VUUUVUVUVUVUVUVU

200.04

fraqueney (MHz)

175.0q

150.0-
o

T T T T
100 200 300 400 500
time (ns)

Figure 3.5: AMS of the overall ADPLL without the
counter
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As we can see that the DCO output frequency is oscillating around the reference
frequency and that is due to the coarse large steps, so we need to stop the coarse

shift register to eliminate the large oscillations.

4 bits counter is used for that purpose and when the counter carry bit activated
the coarse shift register is turned off and the fine one is turned on as shown in

figure 3.6

Transient Eesponse

fine woraja<15:0> | Coo XYmoo

Coarse Wordfgq<15:0>

ffoo fe00 feoo f@oo A fooo e000 conn A g0oo ooon |

1.z5-Jdco_outl

ol [ | ] |

.75

gs_
N

254 —l
o]

-.25

1.7 5 JRETerence Freg

o] | OO0

.75

VoY)

.25

0.0
0 10.0 20.0 200 40.0 50.0 0.0
time {ns)

Figure 3.6: AMS simulation of the overall ADPLL
with counter
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And the result of the Overall ADPLL as a functional (behavioral ) block was as
shown in figure 3.7.

300.0

l
1
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200,04 )
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150.0 T ! ! !
0 200 400 600 800 1000
time {ns)

Figure 3.7: AMS of the ADPLL with counter.

From the above figure we found that the lock time is less than 150 ns which

means that our lock time restriction (lock time < 10 us) is satisfied.

But, the problem is, the above design assuming the reference frequency is fixed

and will not exposed to a step change.

All the above simulation results is done considering the functional behavioral of

the PFD and the Loop Filter (as code only).

We did the technology mapping using Design Compiler by converting the
functional Verilog code of the PFD and the Loop Filter into a netlist to generate
a mapped code which contains the needed standard cells to achieve the block

functionality.
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We extracted the transistor level schematic of the PFD and the Loop Filter
successfully using the standard cells of UMC65nm digital kit as shown in
figure3.8.

retSignal
refsignal [

u2 4 up_dft

A
voo! - N g 1k a
deostgrar 4 dn_dr " oo resedifs_a
deosignal —————————— - ik B 87

a .
resetdff_1 CKND2M2R

a) Imported schematic of PFD in cadence

b) Imported schematic of Loop Filter in cadence

LVl

[H

¢) Imported schematic of PFD and Loop Filter
together in cadence

Figure 3.8: The standard cells of both PFD and
Loop Filter
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As an example we took a snap shot of one standard block inside the PFD

schematic in figure 3.8.a. above
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Figure 3.9: The transistor level of the standard D
flip flop in cadence.
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Chapter 4

LAYOUT

The last step of the design flow is the layout, first of all DCO is considered as the
core of the ADPLL so as we started the design in the schematic scope with the
DCO , we will start with the DCO in the layout scope and we believe that the
range will be changed due to the capacitance and the resistance added by the

layout (i.e. more delay ).

41DCO

The proposed DCO depends mainly on the delay cells (HDCs and DCVs) and

because of the layout, the delay is not the same as schematic any more.

411DCV

Figure 4.1: DCV layout
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Figure 4. 2: DCV block layout

Figure 4. 3: DCV array layout

4.1.2 DCV2

Figure 4. 4: DCV2 layout
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Figure 4. 6: DCV2 array layout

4.1.3 Ring Oscillator

Figure 4. 7: Ring Oscillator layout
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4.1.4 Complete DCO

Figure 4. 8: Final DCO layout

The DCO range was from 3.33 ns to 10 ns of period (i.e. from 100 MHz to 300
MHz), but after constructing the layout directly without any modification to the
sizing of DCVs or removing any fixed delay cells , the DCO range was from 11
ns to 16 ns (i.e. from 62.5 MHz to 90 MHz ) which is out of our required range,
so we had to remove the fixed delay cells (i.e. HDCs) but the range was still not
satisfied, so we started to modify the length of the transistors in the DCV2 cells
because the problem was with the lower bound of the required range (i.e. 100
MHz) and also increase the supply voltage source from 1.2v to 1.5v to satisfy the
required range, and finally we have got 3.236 ns to 9.952 ns (i.e. 100.48 MHz to
309.02 MHz) as shown in figure 4.9.
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Figure 4. 9: DCO operating range in layout.

4.2 PFD

Figure 4. 10: PFD layout

The proposed PFD consists of two D flip flop and OR gate. At the first time ,
when simulating the layout directly with power supply voltage 1.2v , we found
that the functionality of the PFD is not working correctly, so we decreased the
supply voltage to 1v and the PFD worked properly as shown in figure 4.10 and
tigure 4.11.
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Figure 4.12: PFD post-layout simulation.
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4.3 Loop Filter

As mentioned earlier , the proposed Loop Filter in ADPLL is a shift register,

which contains D FF’s and some combinational blocks.

Figure 3.13: Shift Register layout

The post-layout simulation result was different from the pre-layout simulation
due to the delay produced by the layout capacitance and resistance as shown in
figure 4.12 and figure 4.13, but that is not a big deal. As we can see in figure 4.12
in the time period 2.5ns to 5ns the shift occurs at the positive edge of the CLK
signal because the up and down signal are different , but in the same time slot in

figure 4.13 the shift occurred once due to the delay produced by the layout.

Figure 4.14: Pre-layout simulation of the Shift
Register
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Figure 4.15: Post-layout simulation of the Shift
Register

4.4 Overall Design

After constructing the layout of each block in the system, the layout of the overall

design can be constructed as shown in figure 4.16

Figure 4.16: The overall layout
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Figure 4.17: Overall post layout simulation
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4.5 Conclusion

A comparison between the Required Specifications and Achieved Specifications

is held as shown below

Required Specifications Achieved Specifications
Power <1mW 0.6 mW
Area < 0.01mm? From Layout= 0.0086mm?
Lock time < 10 us 1us
P-to-P jitter < 20 ps 35 ps
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Appendix A

AMS TUTORIAL

Through this tutorial you will learn how to simulate a system containing digital
Verilog blocks, digital VHDL blocks and analog blocks. This tutorial is mainly
divided into two parts, part 1 and part 2. For part 1, we are going to simulate a
digital Verilog inverter with an analog inverter and compare the outputs of them,
and then we put them in a cascaded configuration (analog inverter after digital
Verilog inverter) to work together as a buffer. The idea of this cascaded
configuration is to make sure that, the connect rules between the digital block and
analog block are established correctly. For part 2, we are going to simulate
another design contains three main blocks, a digital Verilog 4-bit counter, an
analog 4-bit inverter and a digital VHDL 4-bit inverter. This design is organized
as follows; an external clock signal and reset signal are applied to the Verilog 4-bit
counter. The output of the Verilog 4-bit counter is labeled as count_out<3:0>
and is applied as an input to the next block which is the analog 4-bit inverter. The
output of the analog 4-bit inverter is labeled as vhdl_inv<3:0> and is applied as
an input to the last block which is VHDL 4-bit inverter. The output of the
VHDL 4-bit inverter is labeled as vhdl out<3:0>. We are interested in these

signals, count_out<3:0>, vhdl_inv<3:0> and vhdl_out<3:0>. If everything is

bl

correct, the final output, vhdl_out<3:0> will be the same as the counter output

count_out<3:0>. A block diagram for this design can be found in part 2 section.

Partl:

The following steps are to simulate both the digital Verilog inverter and the
analog inverter and compare both outputs. Another configuration for these two
inverters is to put them in cascade to work as a buffer. We use a library called

ams_tutorial to include all circuits in this tutorial.

Firstly, we will make a cell view for the digital Verilog inverter.
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LiBrary Manager: WorkArea: /usr/locaI/IC614/TSMé_65n7m

Gl Edit View Design Manager Help cadence
Wi Library.
Open. Cirl+0 CelView. | wei—)
Open (Read-Only) ctri+R Category.. _|Cell Mow
Open With,
Load Defaults...
Save Defaults...
Open Shell Window...  Ctrl+P
Exit Cirl+X
[Tambr
ofia
analogLib
hasic
cdsDefTechLib
cds_assertions
cds_inhconn
cds_spicelib
connectLib
functional
ieee
ncinternal
ncmodels
ncutils
~Messages
|[CiE ConnectLib from the same file (defined earlier) = =
Warning: LIB connectLib from File fust/local/IC614/TSMC_B5nm/cds.lib Line 18 redefines
LIB connectLib from File /ust/local/ICE14/00ls.Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
hefore DEFINE connectLib
in fustflocal/ICB14/TSMC_BSnm/cds.lib
Or remove or comment out DEFINE connectLib
in fusrflocal/IC614/o0ls.InxB6/affirma_ams/etc/connect_lib/cds.lib
to suppress this warning message.
[ i
4

File

Library \ams_tutarial '
View=3” Iﬁ
Type => Merilog

Application
Open with Read HDL B

— Always use this application for this type of file

Library path file
fusr/local /IC614 /TSMC_65nm/cds. 1ib

Cancel | Help

After pressing the OK button, you’ll get this menu
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7- /usr}locaI/VIC614HSMC_65nm/ams_tutorial/vi"iibg_iirhv/ —, @} b7

B/Verilog HIL for "ams_tutorial", "verilog_inv" "functional"

module verilog_inv { )3

<r/local /ICE614/TSHC_ESnm/ams_tutorial /verilog_inv/functional/verilog,v" 6L, 98C

It is a little difficult to edit your code in this text editor so, we will use another
text editor called “gedit” by typing the command editor="gedit” in the CIW

window.

[ Virtuoso® 6.1.4 - Log: /root/CDS.Iioig

File Tools Options Sonnet TSMC PDK Tools Help cadence

Loading schHDL. cxt

Warning: ams.env
Loading schematic.cxt e
Loading ahdlSck. cxt =

o B
A QLS

editor="gedit" ~
limouse L: b: R:

IE |

You can now see your cell view and double click on it to edit the code using gedit

text editor
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[ﬂ;rary Manager: WorkArea: /usr/local/IC614/TSMC_65nm

Eile Edit View Design Manager Help

cadence

__ Show Categories __ Show Files
- Library cell

View

ams_tutorial verilog_inv

Plz
USleiLL_TstGS_VZ

adpll
adpll_mixed
adpll_mixed2
ahdlLib

ambit
analogLib
hasic
cdsDefTechLib
cds_assertions
cds_inhconn
cds_spicelib
connectLib
functional

ieee

ncinternal
ncmodels
ncutils

~Messages

ADPLL_Tsinichs_vZ
m

functional

| -
LIE connectLib from the same file (defined earlier)
Warning: LIB connectLib from File fust/local/IC614/TSMC_B5nm/cds.lib Line 18 redefines
LIB connectLib from File /ust/local/ICE14/t00ls.Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
hefore DEFINE connectlib
in fustflocal/IC614/TSMC_BSnm/cds.lib
Or remove or comment out DEFINE connectLib
in fusrflocal/ICB14/o0ls.InxB6/affirma_ams/etc/connect_lib/cds.lib
to suppress this warning message.
s

a

functional

A new window will open up after double clicking your cell view as follows:

verilog.v (}usr/l6c7a7I/lC614/TSMC_65nm/ams_tutorial/verilog;i'mﬁlacfibna - O x

File Edit View Search Tools Documents Help

| Bopen v Fsave |

| verilog.v ¥

3

4 module verilog inv ( );

5
! 6 endmodule

1)//Verilog HDL for "ams tutorial®, "verilog inv" "functional®
2

Verilog v Tab Width: 8 v Ln1, Col 1

INS
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Edit the code and save it.

§ verilog.v (/u;r/idcéln?614ﬂsMC_65nm/ams_tutoriaI/veriAIicrbg;in\ﬁlacfiona SEIC

File Edit View Search Tools Documents Help
| Eopen v Hysave | = | < Undo #a B

[ verilog.v ¢

| 2

‘ 3

4 module verilog inv (input x,output y );

5 assign y = ~x; \
6 endmodule|

Verilog v Tab Width: 8 Ln 6, Col 10 INS

After closing it, you’ll get a menu asking to create a symbol view for your circuit,

press “yes”.

= Céllrvi'éwisymbo'ﬁoesﬁoit' exist x

. Cellview verilog_inv symbol does not exist.
‘\.) Do you want to create it?

Yes Mo Help
T

You can use the created symbol as is or edit it.
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Launch File Edit ¥iew Create Check Opfions Window Help cadence

™ l © @ X @ T, 2 ¢ QA8 %% »@R@ &[]

o

mouse L: mouseSingleSelectPt() M: schZoomFit{1.0 0.9) : schHiMousePopUp()
18 | = | Cmd: Sel: of

We will edit it to take the form of an inverter (optional step).

Launch File Edit ¥iew Create Check Opfions Window Help cadence

D@ 0mXxX0TDE ¢ QL8 W04/ @[

mouse L: mouseAddPt() hd: R: schHitousePopUp()
2(6) | Point at object to stretch Cmd: Stretch  Sel: 0]




We put a something like square wave inside the symbol view to differentiate

between it and the analog inverter. Now it is time to create the analog inverter.

- ~ Newigp x |

File

Library ams_tutorial B
Cell analog inv

View schematic

Type schematic B
Application

Open with Schematics L n

— Always use this application for this type of file

Likrary path file
fusr/local /IC614 /TSMC_65rm/cds. 1ib

Launch File Edit ¥iew Create Check Opfions Migrate Window Calibre Help cédence

™ § 4 O @ % @ T, & ¢ Q& B [P 1L 1 omE

mouse L: mouseAddPt() h: Rotate 30 R: schHitMousePopUp()

3(7) | Use the options form to supply terminal names for the pins | Cmd: Pin_ Sel: 0|
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To create a symbol choose, Create > cellview > from cellview as follows

Launch File Edit View

schematic

A5 Instance

1. Wire (narrow)
1 wire (wide) Shift«W
be Wire Name L

Net Expression...

- Pin
Block.

older Dot
Note
Patchcord
Probe
MultiSheet...

CPE NetSets

mouse L: mouseAddPt()

3(7) | Use the options form to supply terminal names for the pins

hd: Rotate 30

R: schHitousePopUp()
Cmd: Pin  Sel: 0}

Press ok for the next window

Cellview From Cellview ﬁ

Likrary Name

Cell Name analog_inv
From View Name schematic n
To View Name 5 ;nﬂ:n ol

Tool ¢ Data Type schematic

Symbol '

Browse

Display Cellview &

Edit Options v

_Cancel

_ Defaults

_Apply )\ Help
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Symbol Generation Options

Library Name Cell Name Yiew Name
ams_tutorial analog inwv symbol
Pin Specifications Attributes
Left Pins x List.
Right Pins ¥ 7 _List
Top Pins VVDD ’ List'
Bottom Pins  GND 7 List.
Exclude Inherited Connection Pins:
® None o All o Only these:
Load/Save _ Edit Attributes Edit Labels _ Edit Properties
Cancel /| _Apply | Help

We will edit the symbol view to looks like the following (optional). We put a
something like a sine wave inside the symbol to differentiate it from the digital

invertet.

Launch File Edit View Create Ch v Help céden(e

™ ¢ [ O @ %X @ T, & ¢ 1R LAY | ¥ »@4 @ & [

mouse L: mouseAddPt() hd: R: schHitousePopUp()

4(8) | Point at object to stretch \ Cmd: Stretch  Sel: 0|
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Next step is to make a test bench for a circuit containing both the digital Verilog

inverter and the analog one.

| File
Library ams_tutarial
Cell inv_th
View schematic
Type schematic
. Application
| Open with Schematics L n

| — Always use this application for this type of file

Likrary path file

fusr/local /ICE614 /TSMC_65mm/cds. 1ib

Cancel | Help

¥ Show Categories

Library I Category i Cell

[
ams_tutorial ‘ \ analog_iny

ambit inv_th
ams_tutorial verilog_iny
analoglLib
hasic
cdsDefTechLib [
cds_assertions [
cds_inhconn
cds_spicelib
connectLib
functional
ieee
ncinternal
ncmodels
ncutils
HExamples
tLib
sdilib
std
synopsys
tsmc1 3t
tsmcNBS
tutorial
verilog [
vital_memary el

ahdlLih I I

| symbol \

flsyo |

Close Filters...
Gy Nt/

Display...

Help
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Launch File Edit ¥iew Create Check Opfions Migrate Window Calibre Help céuen(e

™ 4 O @ % @ T, & ¢ Q& B [P L 1 omE

mouse L: mouseAddPt() h: Rotate 30 R: schHitousePopUp()
6(10) | Point at object to stretch \ Cmd: Stretch  Sel: 0|

Put labels for input signal, Verilog output and analog output signals.

Add Wire Name

Wire Name Net Expression
MNames Vinp!.lt verilo g_out analo g_out]
Font Height 0.0625 Bus Expansion @ off _ on
Font Style stick B Placement e single o multiple
Justification lowerCenter B ® label U alias
Entry Style fixed ofiset i ® hotiz

Show Offset Defaults

_ 42 Rotate

m _Cancel /| Defaults /| Help

For the input source, a good choice is a periodic signal to test both, high state and

low state. We use Vpulse as an input signal.
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Aadhlgtanceﬁ

Cell -vpulse

View symbol

Names

Array Rows 1

Columns

1

42 Rotate | | Ab Sideways | ‘\ﬁ Upside Down

Freguency name for 1/period

MNoise file name

Number of noise/freq pairs 0

1

DC voltage

AC magnitude

&C phase

XF magnitude

PAC magnitude

PAC phase

Yoltage 1 0w

Voltage 2 1.2v¥

Period 2n s

Delay time '|

Rise time

Fall time

@Y cancel | Defaults | Help

[E—

For this tutorial we use Vsupply = 1.2 v. We will use this value in connect rules

also.
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Eairt?)tﬁ)rj’ect Prop;riies ﬁ

Apply To Pnly current Jnstance
Show _ system & user & CDF
Browse Reset Instance Labels Display

Property
Library Name
Cell Name
Yiew Mame

Instance Name

User Property

lvslghore

CDF Parameter
Noise file name
MNumber of noiseffreq pairs
DC voltage
AC magnitude
AC phase
KF magnitude
PAC magnitude
PAC phase
Temperature coefficient 1

Temperature coefficient 2

MNominal temperature

Yalue

analogLib

vdc

symbol

vl

Add ) Delete | Modify

\; A

haster Yalue Local ¥Yalue

TRUE

Yalue

0

1.2 v

_Cancel ,._Apply /| Defaults /| Previous /| Next /| Help

Display

=

=

=%

i

Display
ff

:

Display

b

I

<

off

The final schematic after adding labels and sources looks like the following
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Launch File Edit ¥iew Create Check Options cadence

= & F=r I v 4

Move

- input

mouse L: mouseAddPt() h: Rotate 30 R: schHitousePopUp()
6(10) | Move | Cmd: wire Name Sel: 0f

Close this schematic and create another cell view for it of type config. Make sure

to choose type config (important).

r )
5 Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm - 0O x
File Edit View Design Manager Help cadence
— Show Categories — Show Files
Library Cell View
ams_tutorial inv_th schematic
ADPLL_TsmcbS_V2 ana
Play M
Pl
adpll_mixed2
ahdlLib
Library ams_tutorial
Cell R
WView config
Application
Snohonal Open with Hierarchy Editor '
leee _ Always use this application for this type of file
ncinternal
ncmo Library path file
neulls | "fusr/local/IC614/TSHC_65mm/cds. Lib
Messages
m Cancel | _Help B
tc/connect_lib/cds. lib
O remove or
in fusrflocal/ICB14/tools.Inx8 =l
to suppress this warning mes il
i
4
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You will get a menu like the following

= Virtuoso® Hierarchy Editor @ -
File Edit View Plugins Help

New Configuration

N ™
Top Cell Top Cell
Eihtarg: Library: |ams_tutorial| B -
Cell: .
Cell.  |inv_th ' <
View:
View. =] @
Open’ | Edit
=== Global Bindings : ot
Library List
Table View R =
Cell Bindingg Wiew List: o

@ l 1 Stop List:
Constraint List:

- Description

| Cancel I Use Template | Help
i N JAC e o : :

b TR N
704) | > |

Press Use Template and choose AMS for Name field from the following

menu.

Use Template'.’f

Template

Name:  AMS

<
Hvilo

From File: cal/IC814/share/cdssetup/hierEditortemplates/&MMS

Cancel Apply Help
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Press OK and choose view as schematic for the section Top Cell like the

following.

New Configuration

Top Cell

Library: ams_tutorial

Cell: Jiny_th
View:

oo
[

Global Bindings

Library List: myLib

Yiew List: avioral functional schematic veriloga vhdl vhdlams wreal

Stop List: spectre

Constraint List:

( (: ( (

Description

Default config view template for O55-hased and Cellview-based Verilog-
aMS netlisters in ADE.
Note:

Please remember to replace Top Cell Library, Cell, and View

fields with the actual names used by your design.

Cancel Use Template Help

After pressing OK you will get the following menu. Choose File>Save
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Virtuoso® H|erarchy Editor: New Conﬁguratlon (Save Needet‘.’|

Edit View Plugins Help cadence
W New Config... B O [

Open... =

&/ X| | Global Bindings 7.8 X

= Open (Read-Only)... \"'v] I 9 -
i Save (Nesded) o Library List:  myLib -~
e save as.. View List: ariloga vhdl vhdlams wreal (...,

Save As VHDL...

Save As Verilog.. Stop List: spectre =

Populate Library... Constraint List: i/

Save Defaults...

Save Cell Table Data...

B
Close Window
() | Library. Cell | ViewFound | WiewToUse |Inherited Yiew Lis| Inherited Lib List|
ams_tutorial analog_iny schematic spectre spice ... myLih
&5 ams_tutorial inv_th schematic spectre spice .. myLib
ams_tutorial verilog_iny functional spectre spice ...  myLib
analogLib vidc spectre spectre spice ... myLib
analogLib vpulse spectre spectre spice ... myLib
tsmcNBS nch spectre spectre spice ... myLih
tsmcNBS pch spectre spectre spice ... myLib

Il MNamespace: CDB& Filters: OFF

7014) | >

Notice that, inv_tb is now having two views, config and schematic.
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Ei'l;rary Manager: WorkArea: /usr/local/IC614/TSMC_65nm e

File Edit View Design Manager Help

cadence

__ Show Categories __ Show Files
- Library cell

View

ams_tutorial inv_th

ADPLL_TsmcbS_V2 analog_inv
Play M
US_8ths

adpll
adpll_mixed
adpll_mixed2
ahdlLib

ambit
analogLib
hasic
cdsDefTechLib
cds_assertions
cds_inhconn
cds_spicelib
connectLib
functional

ieee

ncinternal
ncmodels
ncutils

verilog_iny

~Messages

config

config

schematic

-
LIE connectLib from the same file (defined earlier)
Warning: LIB connectLib from File fust/local/IC614/TSMC_B5nm/cds.lib Line 18 redefines
LIB connectLib from File /ust/local/ICE14/t00ls.Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
hefore DEFINE connectlib
in fustflocal/IC614/TSMC_BSnm/cds.lib
Or remove or comment out DEFINE connectLib
in fusrflocal/ICE14/o0ls.Inx86/affirma_ams/etc/connect_lib/cds. lib
to suppress this warning message.
pes

a

Double click on config and press OK from the following menu

apen Configuration or Top i’.IIViév;

Open for editing
Configuration "ams_tutorial inv_th config”

Top Cell View "ams_tutorial iny_th schematic"

Cancel

 ho

Help

It will open the config view of your circuit. Choose check and Save.
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™ Virtuoso® Schematic Editor L Editing: ams_tutorial inv_tb schematic Config: ams_tutorial inv_ﬁconﬁg WRE [

Launch File Edit Yiew Create Check Options Mig céden(e

=R l © @ X @ T, &2

mouse L: schSingleSelectPt() M: schZoomFit{1.0 0.9) R: schHitousePopUp()
8(18) | = | cmd: Sel: o

Then Launch > IDE L to start simulating your circuit

(This must be done from the config view not schematic view)
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Virtuoso® Schematic Editor L Editing: ams_tutorial inv_tb schematic Config: ams_tutorial inv_ﬁconﬁg WRE \

Create Check Options Migrate Window Calibre Help cadence

ADE XL
ADE GXL
ADS Dynamic Link
Layout XL

Layout GXL

@ X @ T, &3 QQ @& " 1L 18

Schemat

Schemat L

Hierarchy Editor

ixed Signal Options »
Simulation » ) C . ' ' .~ " aonalog_out
Diva

Parasitics

mouse L: schSingleSelectPt() M: schZoomFit{1.0 0.9) R: schHitousePopUp()
8(18) | > | cmd: sel: of

Then choose Setup>Simulation/Directory/Host.. from the following menu

=0 ]

Analyses Variahles Outputs Simulation Results Tools Help cadence

_ #2 Design ... Analyses 7.8 x| -
DeslnY simulator/Directory/Host ... 8 ble| Arguments | F‘!“

Nal™ Turbo/Parasitic Reduction .. “AC
Model Libraries .. ans

Temperature ... [}1]

Stimuli ... o

Simulation Files ... o

MATLAB/Simulink » K

Environment ...

Outputs 78 x| Q

NamefSignal/Expr ~ —| Malue | Plot| Save| Save Options | O

kAL

Plot after simulation: Auto i@  Plotiing moce: Replace i

mouse L; h: R
3(17) | Simulator/Directory/Host ... | status: Ready | T=27 C | Simulator: epectre}

Choose simulator as ams and press OK
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Session

Design Vaf Simulator spectre '
. ADSsim A
‘—MT Project Directory aps
hspiceD
Host Mode spectre « distributed
UltraSim
Host ~ ==mmmme—

spectreerilog

Remote Directory
UltraSim¥erilo

Cancel /| Defaults . &pply | Help

-© © x ¥ Bl g+ O

Outputs 78|
" Name/SignalExpr | Value| Plot| bave| Save Options |
\ \
Plot after simulation: |Auto ' Plotting mode: Replace ' P |
I mouse L: : R
3(17) | Simulator/Directory/Host ... | Status: Ready | T=27 C | Simulator: spectre]

The next step is to edit the connection rules. Choose Setup>Connect Rules

B Virtuoso® Analog Design Environment (1) - ams_tutorial inv_tb r'.’||ﬁg
Session Analyses Variables Outputs Simulation Results Tools Help cadence
' #2 Design .. ses @ZEx] =
DESICY Simulator/Directory/Host ... = | Enable], Arguments | E
Performance/Parasitic Reduction ... tsg
Model Libraries ... Chiany
Temperature ..

Simulation Files ...

(i
Connect Rules ... <_l KZ
b4

MATLAB/Simulink »
Environment ...

Outputs @@_,,&q e

Name/Signal/Expr  —| Value| Plot| Save| Save Options @

\\/

Plot after simulation: Auto ' Plotting mode: Replace ' )

Il mouse L: I: : R:
3(17) | Connect Rules ... | Status: Ready | T=27 C | Simulator: ams(Spectre)Mode: natch]
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You will get a menu looks like the following.

amsl: Serlect Connecg leIAes

List of Connect Rules Used in Simulation

Type Rule Mame Details

Built-in " ConnRules_18V_full_tast Lib:connectLib View:connect

B
.7 il

D)
Enable Disahle Delete Rename... Copy... Bl Down ICustomize...l
o V. S Y v < V& & =

Built-in and Customized rules 1‘{

Rules Name I,connectLibConnRulesJ8V_fu|l_fast m Wiew...
Description This is the description for ConnRules_18¥_full fast Customize...

1= ]

User-defined rules for ncvlog,ncelab,ncsim

Library . Browse...
Cell Add
View

Cancel ) Apply Help

For this tutorial we use Vsupply=1.2v which is not included in the attached rules
so we will choose any one and edit it using the Customize button. We will set
Vsup to 1.2v instead of 1.8v and vthi to 0.8v (2¥Vsup/3) and vtlo to 0.4v
(Vsup/3). Do not forget to press the button Change after changing any value of
these values. Vthi means threshold value for high logic and vtlo means threshold

value for low logic. The range between vtlo and vthi is called the forbidden zone.
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amsl: Customize Built-in Rules '."l

Description  This is the description for ConnRules_18V_full fast

Connect Module Declarations

EZR
RZE_2
ER_hidir
LZE_2_CPF
Bidir_2_CPF ysup=1.
-

=3
MMode (B¢
Parameters T

MSup

Parameter  wsup value [1.2 Change ‘<:

Direction1 5’;'7 Disciplined

Directionz E) Disciplinez

. Connect Resolutions... |

\Cancel /|_Apply |_Disciplines.. ,_Help
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amsl: Customize Built-in Rules '."l

Description  This is the description for ConnRules_18V_full fast

Connect Module Declarations

E2R
RZE_2
ER_bidir
2B Z-CER wsup=1.2 v
Bidir_2_CPF vsup=1.2 ¥
O
Made %
Parameters i

vtlo 0.6
Wsup/ed
“Vijeltasd

Parameter  wthi Yalue 0.8
Direction1 5’;'7 Disciplined

Directionz E) Disciplinez

. Connect Resolutions... |

\Cancel /|_Apply |_Disciplines.. ,_Help
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amsl: Customize Built-in Rules '."l

Description  This is the description for ConnRules_18V_full fast

Connect Module Declarations

EZR
R2E_2
ER_hidir vielta="Ysup/6d v
lL2E_ Z-CPF wsup=1.2 vlo=0t n rlo=200 rhi=200 rx=40
Bidir_2_CPF vsup=1.2 vthi=0.8 0.6 tr=0.2n tf=0.2n rlo=200 r
(%

Mode &)
Parameters

vthi
viio
Wsup/ed
“Vdeltasd
Tri2z0
Parameter  wvtlo value 0.4 Change 1@
Direction1 & Disciplinet
Directionz [’:g Disciplineg
. Connect Resolutions.. |

\Cancel )| _Apply /(_Disciplines.. )\ _Help

Then choose analysis and we will simulate the circuit for 10ns

77



1= C'hoosiing Anéiyses -- Viﬁuoso@ﬁﬁélog Design

Analysis @ tran o dc o ac o envip

Transient Analysis

Stop Time 10n

&accuracy Defaults (errpreset - Spectre Only)

~ conservative __ moderate __ liberal

__ Transient Noise

Enahled Options...

Cancel ) Defaults )| Apply /| Help

Then select the signals to be plotted Outputs>To Be Plotted>Select On

Schematic

[ ] Virtuoso® Anélog De;igin Environment (1) - ams_tutoriiiailiiihv_t'b r'.’ilﬁg

Session Setup Analyses Variables SN Simulation Results Tools Help cadence
N fa= setup .. Ziax] =
Design Variables Delete y Arguments | g
Name. | Malue : To Be Saved » | 010n conservative e
=
Save All . | Select On Schematic c @
Select From HED

Add To e

Remove From %

Qutputs 78 x| e

| NameiSignaliExpr  —| ¥alue| Plot| Save| Save Opfions | @

WA J
v\

Plot after simulation: Auto n Plotting mode: Replace B

-
Il mouse L: I R:
3(17) | To Be Plotted | Status: Ready | T=27 C | Simulator: ams(Spectre)Mode: batch|

We are interested in these signals, input, analog_out and Verilog_out.
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B® 7vi'rt7uoso®7Anaﬁloig Design Environment (1) - ams_tutorgliinv_t'l’) ;'-=||ﬁg

Session  Setup Analyses Mariables Outputs Simulation Results Tools Help cédence
: ) Analyses 728 x| —
R0 Balons _ Type - | Enable] ~Arguments | Y
. MName =] Male | |[1tran v 0 10n conservative e
=
5
Im-t
b
Qutputs 7.8 X e
Name/SignaliExpr = | Value| Plot| Save| Save Options | ()
1 input ¥ | _ no 3
2 analog_out ¥ (@ [no .\
3 verilog_out ¥ | [no
Plot after simulation: Auto ' Plotting mode: Replace '

I mouse L: : R:
9(17) | Select On Schematic | Status: Ready | T=27 C | Simulator: ams(Spectre)iode: batch|

Then Run Simulation. The following are the results from both the analog inverter

and the Verilog digital inverter and they are the same.

R ActiVeTams_tutorial inv_tB config : Jul 5 13:43:54 20'.’. 19

File Edit Frame Graph Axis Trace Marker Zoom Tools Measurements Help cadence

SGr#ENFEeRBE »uFER MO BX-HEE -~

Juls, 2014 Transient Response E

Jverilog_out I | | | | | | I | |

JFanalog_out L
1.2547 g

1.0

=25
1,25 7input

1.0

5]

Y (V)

5]

251

0.0 T T
o} 2.5 5.0 7D 10.0

[ 6.8676ns] St0 time (ns)

9 >
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We will now try the cascaded configuration of both inverters to act as a buffer.

Virtuoso® Schemati i i : ams_tutorial buffer_tb schematic
Launch File Edit View Create Check Opfions Migrate Window Calibre Help cadence
= e © @ %X @ T, &3 ¢ QR Q & & [ 1L 1L &8

mouse L: schSingleSelectPt) M: schZoomFit(1.0 0.9) R: schHiMousePopUp(
10(20)

[ Cmd: Sel: 0

The simulation result can be found in the following figure. One can simply notice
that, the analog_out signal is the same as the input signal. (The operation of a

typical buffer).
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s
File Edit Frame Graph Axis Trace Marker Zoom Tools Measurements Help cadence

Sr#EsElFeBE »uR MBX Pl S ——
Jul 5, 2014 Transient Response 1]

1.25{/nput
1.0

754
=
»  5J

.25

0.0
1.25- fverilog_out L

1.0

759

e
=

259

04

-.25
1.25- 7analog_out

-.25
.25 T T T
1] 2.5 5.0 7.5 10.0

[12.893ps[ 773.566mV time {ns)

@ > graphl selected: double-click to bring up attribute dialog.

Part2:
In this part we are going to simulate a design consisting of 3 main blocks, digital
Verilog 4-bit counter, analog 4-bit inverter and digital VHDL 4-bit inverter. The

block diagram of this circuit is as follows
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el

reset

0

dout<3:0>
count4

count_out<3:0>

VDD

vdc-12

GND

3
vdc-0

lcount_out< 1>

GND.

vhdLiny<2>

vhdl_inv<3:@>

vhd|_out< 30>
4 x<3:9> vhdl_inv y<3:0>

vhdl_iny<t> &

ant count_out<@>

The analog inverters are taken from Part 1 and the codes for Verilog counter and

VHDL inverter is as follows

module count4(input clk,reset,output[3:0] dout);
reg[3:0] count_reg;
wire[3:0] count_next;
//state register
always@(posedge clk,posedge reset)
if(reset)
count_reg <= 0;
else
count_reg <= count_next;
//next state logic
assign count_next = count_reg+1;
//output logic
assign dout = count_reg;
endmodule

library IEEE;

use IEEE.STD_LOGIC_1164.all;

entity vhdl_inv is

port (x: in STD_LOGIC_VECTOR (3 downto 0);
y: out STD_LOGIC_VECTOR (3 downto 0));
end;

architecture behavioral of vhdl_inv is

begin

y <= not x;

end;

We will start by importing both the Verilog counter and the VHDL inverter into

virtuoso. The following figure is to import the Verilog counter.
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-

Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm ﬁj - o x

File Edit Miew _oo_____** cadence

_ Show Catego

vorary —— I v

EDIFz00

ams_tutarial Refresh =>| Verilog.. | config
FOPLLTMERE,  pake moad Only.. VEDL.

Flay Spice I | [scrematc
Us_sths Bookmarks 4
adpll — DEF.
adpll_mixed [ 1 ams_tutorial buffer_th config LEF...
adpll_mixed2 ; Stream
ahdILib <& 2 ams_tutorial inv_th schematic i .

- ) " Netlist View...
ambit & 3 ams_tutorial buffer_th schematic
analogLib [ 4 ams_tutorial inv_to config
hasic < 5 ams_tutorial analog_inv schematic
cdsDefTechLib

- 4 i
cds_assertions [ 6 ams_tutorial verilog_inv symbol
cds_inhconn E} 7 ams_tutorial verilog_inv functional

cds_spicelib .
coRnaeiLi “® § ADPLL_TsmcB5_V2 Overall_Test schematic
functional <& 3 adpll dcvz_th schematic
o0 ® 0 ADPLL_TsmcBS_V2 dev_th schematic
ncinternal
:smﬂgels Close Data...
Exit... Sl
Messages M Tools Options Sonnet TSMC PDK Tools Help cadence
T
LIB connectLi ocal/IC614/TSMC_65nm/cds. Lib
Warning: LIB ¢ = tLib
H?eff&’\‘l%?glﬁ“' £irma. ams/ete/connect: 1ib/cds: 1ib
hefore DEFING S v
in fusr/locall] - g i > v
Or remove or
in fusrflocall
to suppress thi | i mouse L: M
= 1 -

Choose Target Library and Verilog file as follows
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Ve}i4log In

Impart Options Glohal Net Options Schematic Generation Options

File Filter Name

froot/Desktop/ams_tutorial/

Target Library Name ams_tutorial I Browse
kil ddial i ——— N/

Reference Libraries hasic

Yerilog Files To Import ‘root/Desktop/ams_tutorial/countd. v | Add |

-f Options Add
i/

-y Options &dd
it/

-y Options add
Nl

Library Extension

Library Pre-Compilation Options

Pre Compiled Verilog Library

HDL View Name hdl

Target Compile Library Name Browse

Compile Verilog Library Only

Ignore Modules File . Add
N —
Import Modules File Add
N
Import Structural Modules &s  schematic

Structural View Names

:}- Cancel Defaults &pply ) Load Save Help

‘a- - 1 o

You will get a menu like the following after pressing OK. You may press Yes to
view the logfile.

@ INFO (VERILOGIN_GUI-15): Verilog Import completed. Look at logfile, /veriloginlog, for process execution details.

Yes ]
N/

|| Help
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The logfile looks like the following. Reporting that your import process has been
completed.

Log File

File Help cadence

[-]

[e(#)$cDS: ihdl version 6.1.4 11/17/2009 20:48 (sj£d1221) § Sat Jul 5 14:38:52 2014 =

INFO (VERILOGIN-357): Checked in symbol countd.

INFO (VERILOGIN-345): Checked in functional wiew countd. Register Declaration found
INFO (VERILOGIN-206): End of Logfile.

30

Now check your target library (ams_tutorial in out example) to find the Verilog

counter count4 with two views, functional (The Verilog code) and symbol.
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Library Manager

FEile Edit View Design Manager Help cédence
_ Show Categories __ Show Files

- Library Cell View
ams_tutorial countd|
ADPLL_TsmcbS_V2 analog_inv functional
Play buffer_th symbol
US_8ths cds_globals
il
adpll_mixed inv_th
adpll_mixed2 vetilog_iny
ahdlLib
ambit
analogLib
hasic

cdsDefTechLib
cds_assertions
cds_inhconn
cds_spicelib
connectLib
functional

ieee

ncinternal
ncmodels
neitile (] J

. Messages

T
LIE connectLib from the same file (defined earlier)
Warning: LIB connectLib from File fust/local/IC614/TSMC_B5Snm/cds.lib Line 18 redefines
LIB connectLib from File fusr/local/IC614/tools.Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
hefore DEFINE connectlib

in fusrflocal/IC614/TSMC_BSnm/icds.lib
Or remove or comment out DEFINE connectLib

in fusrflocal/ICB14/tools.InxB6/affirma_ams/etc/connect_lib/cds.lib
to suppress this warning message.

[
4
Double click on functional to check the code.
-
| B8 Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm ﬁj _ o x|
File Edit View Design Manager Help cadence
__ Show Categories __ Show Files
- Library cell View
ams_tutorial countd functional
ADPLL_TsmcB5_V2 analog_inv functional
Play huffer_th
US_8ths
adpll
adpll_mixed
adpll_mixed2
ahdlLib n N
ambit File Edit View Search Tools Documents Help
ams_tutorial : :
analogLib |"] &3open v [ save | v

hasic

cdsDefTechLib |7 verilog.v %

cds_assertions

cds_inhconn 1)// Created by ihdl |2
cds_spicelib 2 module count4(input clk,reset,output[3:0] dout);
fcu?nnn:rtluenﬁla_\m 3 reg[3:0] count reg;
ol 4 wire[3:0] count_next;
ncinternal .
nemodels 6 //state register
netils 7 always@(posedge clk,posedge reset) s J
8 if(reset) E |
| Messages 9 count_reg <= 0;
— |10 else
LIB connectLib from the same file (defined earlier}|qq count reg <= count next;
Warning: LIB connectLib from File /ust/local/ICB1 = i =
LIE connectLib from File /ust/local/ICE14/tools.In i //n?Xt state logic
Insert UNDEFINE connectLib 13 assign count_._next = count_reg+l;
before DEFINE connectLib 14 //output logic
in fusr/local/ICE14/TSMC_BSnm/icds.lib 15 assign dout = count reg;
Or remove or comment out DEFINE connectLib = =
in fust/local/ICE14/00ls.InxB6/afiirma_ams/etc/ Verilog v Tab Width: 8 Ln1, Col 1
to suppress this warning message.
{7 il

IN

Double click on symbol view to check the symbol. You may need to edit it, we

will just leave it as is.
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Launch File Edit ¥iew Create Check Opfions Window Help

cadence

™ ¢ 0 m@mx @

&5 »Q 4@ @[

mouse L: mouseSingleSelectPt()
15(32)

h: impHdIDisplay{impHdlOptionsF ormhdain)

R: schHitMousePopUp()
| Cma: Sel: of

Next step is to import the VHDL 4-bit inverter.

Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm 17

v

X

=]

cadence

Library E View
Export » EDIF200
v "
Refresh... Verilog. symbol
Make Read Only l—D [_veor.
Bookmarks »
| 1 ams_tutorial countd symbol
‘a'- 2 ams_tutorial countd functional
= v ” - Netlist View.
% 3 ams_tutorial huffer_th config
& 4 ams_tutorial inv_tb schematic
“® 5 ams_tutorial buffer_th schematic
assertions | O% 6 ams_tutorial inv_th config
inhconn & 7 ams_tutorial analog_inv schematic
connectLib [ 8 ams_tutorial verilog_inv symbol
functional [ 9 ams_tutorial verilog_inv functional
leee ® ( ADPLL_Tsmc6S_v2 Overall_Test schematic
ncinternal
ncmodels Close Data
neutile 0qg 00 D 0g 1]
Exit. ] i
Messages Tools Options Sonnet TSMC PDK Tools Help cadence
e -
LIB connectLitfT S S R AT BT EaE =
L‘[é”c‘:j"n“[ ;‘f‘u‘r INFO (VERILOGIN_GUI- Verilog Import proce ||
\hi‘en.UPv‘lD'EFli INFO (VERILOGIN GUI- Verilog Import compls fverilogIn. log, for process exe/=
before DEFINE| ¥arning: ans. env i
mouse L: awvhMouseSingleSelectPtCB() b: R: impHdIDisplay(impHdIOptionsFormbdain} —
= | =
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Choose your target library (ams_tutorial in our example) and VHDL file. Leave

all other fields as

. _ _ i
] VHDL Import x

File Edit View Design Man

they are.

Schematic Generation Options

i

A
- 0 X

cadence

File Name Target Library Name
_ Show Categories o —— -
3 ams_tutorial
Library
vhdl 1nv. vhd
ams_tutorial vhdl_inv.vhd |
ADPLL_Tsmcbs_v2 1
Play
Ri
US_Bths \EETEMAVE, )
adpll
adpll_mixed
adpll_mixed2 X
ahdiLib #root/Desktop/ams_tutorial/*. vhd
ambit
analoglib Import Structural Architectures &s schematic
hasic
cdsDefTechLib Reference Libraries basic US_8ths ieee std |
cds_assertions
cds_inhconn Symbol View Name symhol
cds_spicelib
connectlib Ovenarite Existing Views v
functional
Jeee Case Sensitive Symbol Matching v
”C‘medml""' User Specified Standard Libraries &
ncmodels -
Aetils m Maximum Number of Errors 10
| Messages File Tools Compile YHDL Views After Import J
- Compiler Options
LIE connectLibED suppress
Waming: LB €] e (VERIL)  yHDL WORK Library Name
INFO (VERIL
Insert UNDEFIH| ¢ >
before DEFINE| 7arning: an Summary File . /vhdlin. sunnary
in fust/localy -~ [
Or remove or ¢ Cory Option |
in fustilocallf
to suppress tis  mouse L: au +33 Option o
— . Power
et Nama oddl T wame e

After pressing OK you will get

logfile.

Yes No | Help
R I SRS

- 0O X

cadence

pr process exe

R: whdiHilmporty  —

o, QUESTION (¥HDLIN_GUI-83): ¥YHDL Import completed successfully.
(?) po you want to view the log file?
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File Help cadence

@{#)$CDS: vhdlin version 6.1.4 11/17/2009 20:49 (sjfnl007) $ Sat Jul 5 14:46:25 2014

INFO (VHDLIN-238): Processing VHDL source file: /root/Desktop/ams_tutorial//vhdl_inv.vhd.

INFO (VHDLIN-264): Done.

INFO (VHDLIN-244): Vhdl Design Unit: vhdl inv : Entity

INFO (VHDLIN-243): Created symbol view of type symbol.

INFO (VHDLIN-245): Created entity view of type Vhdl

INFO (VHDLIN-251): Vhdl Design Unit: vhdl inv.hehavioral : Architecture

INFO (VHDLIN-245): Created behavioral wview of type Vhdl

INFO (VHDLIN-255): -> (froot/Desktop/ams_tutorial//vhdl inv.wvhd, 9) Behavioral expression.

EE TS

INFO (VHDLIN-229): Number of file(s) processed in this round is 1

Fhkkhk

INFO (VHDLIN-231): Number of file(s) successfully imported in this round is 1

[INFO (VHDLIN-284): VHDL In Run Summary -

33|

Now you can check your cell, named vhdl_inv.

Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm

cdsDefTechLib

cds_assertions

cds_inhconn

cds_spicelib

connectLib

functional

ieee

ncinternal

ncmodels

neitile ke

| Messages

| -
LIE connectLib from the same file (defined earlier)

Warning: LIB connectLib from File fusr/local/IC614/TSMC_B5Snm/cds.lib Line 18 redefines

LIE connectLib from File /ust/local/ICE14/tools.InxG6/afirma_ams/etc/connect_lib/cds.lib

Insert UNDEFINE connectLib

hefore DEFINE connectlib
in fusrflocal/ICB14/TSMC_BSnm/cds.lib

Or remove or comment out DEFINE connectLib e
in fusrflocal/ICE14/Ao0ls.Inx86/affirma_ams/etc/connect_lib/cds lib

to suppress this waming message. e

File Edit View Design Manager Help cédence
__ Show Categories _ Show Files

- Library Cell View
ams_tutorial vhdl_inv| symhbol
ADPLL_TsmcB5_V2 analog_inv hehavioral
Play huffer_th entity
US_8ths cds_globals
adpll countd
adpll_mixed inv_th
adpll_mixed2 verilog_iny
ahdlLib
ambit
analogLib
hasic

Double click on behavioral view and entity view to check the code.
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Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm

%

E

(2 vhdl.vhd (“usr‘local«‘IC614‘TSMCﬁSnm“amsitutorial“vhdlj;‘?bchavi( =iRE X cadence

il File Edit View Search Tools Documents Help
Eopen v Gsave R vew

vhdl.vhd ¢ | enity

1-- Created by @(#)$CDS: vhdlin version 6.1.4 11/17/2009 20:49 b
(sjfnle67) $
2 -- on Sat Jul 5 14:46:25 2014

symhol

3
4
5 architecture behavioral of vhdl inv is 1 X
6 begin & vhdl.vhd (/usr/local/IC614/TSMC_65nm/ams_tutorial/vhdl_jfj/entity) - o x |
7 = not Xx; N " " T o T e =
BZn;- File Edit View Search Tools Documents Help
& open v [ save 2 ﬁ
1
vhdl.vhd
1 -- Created by @(#)$CDS: vhdlin version 6.1.4 11/17/2009 20:49
(sjfnlee7) $
VHDLv T| 2 -- on Sat Jul 5 14:46:25 2014
nemnuuers =)
neutile 4 4
5 library IEEE;
Messages 6 use IEEE.STD LOGIC 1164.all;

T e DI TOTOroTETTD 7 entity vhdl inv is
LIB connectlib from the same file (defined earlier.) 8 port (x: in STD_LOGIC_VECTOR (3 downto 0);
Warning: LIB connectLib from File f 4 & = = = % St
LIB connectLib from File /ustflocal/iC614/0ols Inxa(| 9 ¥ out STD_LOGIC_VECTOR (3 downto 0));
Insert UNDEFINE connectLib 10 end;

nnectLib 11

nectLib
al/IC614/tools.InxB6/aflirma_ams/etc/cq
to suppress this warning m ge

— VHDL v Tab Width: 8 v Ln4, Col 1 INS

You can edit the symbol. We will use it as it is.

Launch File Edit

‘ e - o . e
™ € 0 @ % @ ¢ |1 KX K

mouse L: mouseSingleSelectPt() : whdlHilmport() R: schHitousePopUp()
16(36) | > | Cmd: Sel: |
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Next step is to make the test bench for the block diagram mentioned in the

beginning of this section. We will name it mixed_tb (optional).

File

Library ams_tutorial
Cell mixed_th
View = l::'}.‘;ema.tirn:
Type schematic

Application

Open with Schematics L

Likrary path file

— Always use this application for this type of file

fusr/local /IC614 /TSMC_65rm/cds. 1ib

Launch File Edit Yiew Create Check Options Migrate

Window Calibre Help

cadence

P d(® 0 EX0O T

3 = 5 A
(4 W = o

mouse L: schSingleSelectPt()
17(37)

M: schZoomFit{1.0 0.9)

R: schHitMousePopUp()
| Cma: Sel: of
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Choose create>wire (wide) to create buses.

Launch FEile Edit Yiew

Window Calibre Help

al mixed_tb schematic

& & %

nstance

Wire (narrow)

Wire (wide)

Shift+W

Wire Name

Net Expression...

I

- Pin

Block
Cellview
Solder Dot
Note
Patchcord
Probe
MultiSheet...

CPE

Q Q Q

mouse L: schSingleSelectPt])
1737 | >

M: schZoomFit{1.0 0.9)

R: schHiMousePopUp()
| Cmd: Sel: 0

Connect these blocks together as follows
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Launch File Edit ¥iew Create Check Opfions Migrate Window Calibre Help

cadence
B dld 0mx O TEs e |[QQQ & M 1 e

mouse L: mouseAddPt() I: Rotate 90
17(37) | Point at object to copy

R: schHitMousePopUp()
| cmd: Copy  Sel: 0f

Add labels for buses by pressing 1.

[ Add Wire Name & 1

"~ Wire Name Net Expression
Names count_out< 3.0 '.;}:Lrél:l'_im-{if: -0
Font Height 0.0625 Bus Expansion @ off _ on
Font Style stick B Placement & single o multiple
Justification lowerCenter ﬂ Furpose ® |abel _ alias
Entry Style fixed offset B Bundle Display e hi rerti

__ show Offset Defaults
_ 42 Rotate

m _Cancel | _Defaults | Help
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Launch File Edit ¥iew Create Check Opfions Migrate Window Calibre Help céden(e

PR E P O0EXOTE S @ |QQR’RE [T L L E

h: Rotate 30 R: schHitMousePopUp()

mouse L: mouseAddPt()
| Cmd: wire Name Sel: 0|

17(37) | Use the options form to supply the wire names.

Add labels for the wires connected to the buses.

Add Wire Name

"~ Wire Name Net Expression
Names count_out<3:0> |
Font Height 0.0625 Bus Expansion
Font Style stick B Placement

(®

Justification lowerCenter n Purpose

Entry Style fixed offset n Bundle D

Show Offset Defaults

42 Rotate

m _Cancel | Defaults | Help

After pressing OK, left click on the first wire and move to the last wire across the

wires between them and finally left click on the last wire.
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cadence

E@Edld0mXx0LEs ¢ |AKAR % LLESE

mouse L: mousesddPt) hd: Rotate 90 R: schHitouseFopUpi)
17(37) | Use cursor to bring rubberband across wires to be named Crd: Wire Mame Sel: D|

Launch File Edit View Create Ch Winc Calibre Help cadence

P d % O @ X

=
2}
L
oT
=3
=

&3]

mouse L: mouseAddPt() M: Rotate 90 R: schHiMousePopUp()
17(37) | Use cursor to bring rubberband across wires to be named ‘ Cmd: Wire Name Sel DE
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Launch File Edit Yiew Create Check Optio Migrate

alibre  Help

&Rl omx QTS

QQa’ %L1

mouse L: mouseAddPt()
17(37) | Use the options form to supply the wire names.

I: Rotate 90

R: schHitMousePopUp()

| Cmd: Wire Name Sel: 0

Add sources to your design clk, reset, VDD and GND. For the clk we use

Vpulse with period 2ns.
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Add lnstance'."

Cell vaulse I

View symbol

Names

array Rows 1 Columns 1

42 Rotate | Ak Sideways | | Upside Down

Freguency name for 1/period

MNoise file name

1

Number of noise/freq pairs 0

DC voltage

AC magnitude

&C phase

XF magnitude

PAC magnitude

PAC phase

Yoltage 1 0w

Voltage 2 13:2:%

Period 2n s

Delay time

Rise time

[R—

@Y cancel | Defaults | Help

Fall time

For the reset signal, we use Vpwl with the following configuration for an active

high reset.
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Add lnstance'."

Likrary analogLib Browse

Cell vpwl

View symbol

Names

array Rows 1 Columns 1

42 Rotate | Ak Sideways | | Upside Down

il

Freguency name for 1/period

Number of pairs of points I 3 I
Time 1 IU s I

Yoltage 1 1.2 v
Time 2 In s
Voltage 2 1.2 ¥

Time 3 l.1ln s

Voltage 3 0¥

MNoise file hame

|

Number of noiseffreq pairs

DC voltage

AC magnitude

AC phase

b pe PR Y W [ —_—

@Y cancel | Defaults | Help

The final schematic after adding sources and labels is as follows



Launch FEile Edit Yiew Create Check Options Mi Window Calibre Help cadence

¢ UK S & & 1% 1L 1 &

™ ¢ Eft%\jLJXQ
I

mouse L: mouseAddPt() h: Rotate 30 R: schHitousePopUp()

17(37) | Use the options farm to supply the wire names. | Cmd: Wire Name Sel: D

Check and Save then close this schematic and create a config view for it as we

did for Part 1.

r ~
54 Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm - 0O x
File Edit View Design Manager Help cadence
— Show Categories — Show Files
Library Cell View
ams_tutorial mixed_th schematic
ADPLL_TsmcbS_V2
Play

1I_mix

adpll_mixed2
ahdlLib

File
Library ams_tutorial n
Cell d_th

s View config

functional I Type =>

1 lication

ncinternal i T n

ncmo Open with ierarchy Editor

neudis — Always use this application for this type of file

Messages Library path file

Ausr/local/IC614/TSMC_65nm/cds. 1ib

- —
LIB connectlib
Warning: LIB connectLib from File 4
ectLib from File fusr/locals
Insert UNDEFINE connectLib

before DEFINE connectlib Cancel | |_Help

nect_lib/cds.lib
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Virtuoso® Hiera;cﬁy Editor: New Configuration (Save Needret""-’i

File Edit ¥iew Plugins Help cadence
e e dllz s s ¢ B | B
Top Cell 7.8/ x| | Global Bindings 7.8 X
Library: ams_tutorial Library List: myLib -
Cell:  mixed_tb Wiew List: stiloga vhdl vhdlams wreal
View:  schematic
Stop List: spectre i)
N~
Open | Edit Constraint List: i
Table View Tree View
Cell Bindings
() | Library | Cell | ViewFound | WiewToUse |[Inherited View Lis| Inherited Lib List
ams_tutorial analog_iny schematic spectre spice ... myLih
ams_tutorial countd functional spectre spice .. myLib
£ ams_tutorial mixed_th schematic spectre spice ...  myLib
ams_tutorial vhdl_inv hehavioral spectre spice ... myLib
analogLib vdc spectre spectre spice ... myLib
analogLib vpulse spectre spectre spice ... myLih
analogLib vpwl spectre spectre spice ... myLib
tsmcNBS nch spectre spectre spice ... myLib
tsmcNBS pch spectre spectre spice ... myLih

|| Namespace: CDBA  Filters: OFF
18(39) | » |

Choose the ams simulator as we did for Part 1 and edit connect rules then

select signal to be plotted.
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B \Virtuoso® Analrog Design Environment (3) - ams_tutoriralr mi'xed_tl"-"pnﬁg

Session  Setup  Analyses Variahles @ma Simulation Results Tools Help cédence

Design Variables k- i:i?e“ : 7.8 x| g
| Name =] Malue To Be Saved » riﬂ 10n conservative o
Save All .. Select On Schematic @
Select From HED
Add To ﬁ:
Remove From x
Ou'ﬂuts 3@_,.x! °

o
<

Plot after simulation: |Auto ' Plotting mode: Replace ' ) |
. o H

limouse L: hl: R:
20{42) | Remove From | Status: Ready | T=27 C | Simulator: ams(Spectre)Mode: batchl

We are interested in plotting these signals, count_out<3:0>, vhdl_inv<3:0> and

vhdl_out<3:0>.

Select bits from l:'.’.

count_out<3>
count_out<2>
count_out<l>
count_out<0>

L Select All I\ Deselect All )

(@CL)| cancel | _Help
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Select bits from tﬁ

| Select All I Deselect All

Cancel )| _Help

Ointiane b dic

st tindow. Lisrarshi Editar AMS. Calibre  Help
Select bits from bus

Deselect All

imouse L: schSingleSelectPt() M: sevChangeOutsOnSchematic('sevSession3 ‘plof) R: schHiMousePopUp()
18(41)| > modify_plot Cmd: Sel: 1 Status: Selecting outputs to be plotted \T:Z? C | Simulator: ams{Spectre)Mode: batch|

Then Run Simulation.
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Virtuoso® Analog Design Environment (3) - ams_tutoﬁai mfxed_tb conﬁ'.’.

Session  Setup Analyses Variables Outputs Simulation Results Tools Help cadence
e Analyses 7&@@
esign Variables
Y _ Type - | Enable| Arguments. |
[ Name - | Walue | || tran v 0 10n conservative

Outputs

<

=7
<.

. vhdl_inv<3>
vhdl_inv<2=
3 vhdl_iny<1=>
12 vhdl_iny<0=
.1_14 vhdl_out<3>
12 vhdl_out<2=>
13 vhal_out<1>
li vhdl_out<0=

KKK KKEKRKEKIKEKIKIRK /K

Plot after simulation: Auto n Plotting mode: Replace '
L

Il mouse L: It R:
20(42)| Select On Schematic Status: Selecting outputs to be plotted... | T=27 C | Simulator: ams(Spectre)Mode: batch|

From the results figure, we can select the digital signals of vhdl_out<3:0> and

convert them to a bus.
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File Edit Frame Graph Axis Trace Marker Zoom Tools Measurements Help cadence
& @ # FERE » s EEN 860Xt HE — [~
Juls, 2014 i

B /vhdl_inv<0> [[l/vhdi_inv<1> [l/vhdi_inv<2> RR/vhdl_inv<3> [RE/count_out<0>

B /count_out<l> [l/count_out<2> REE/count_out<3> [E/reset

1.25 e

1.0

75

v (¥)

=25

[ 9.508ns| Sto

5N 7.5
time (ns)

|— FIdLS

10.0

Create Bus

| Bit Signal

10 (Ish) |[/vhdl_out<0>
11 |/vhdl_out<1>
Jvhdl_out-

13 (msh) |/vhdl_out<3:

> |/root/simulatio

l Results Directory l

|/root/simulation/mi...

|/root/simulation/mi...

|/root/simulation/mi...

|alpha Sort

Bus Name ‘

|

oo e

Radix|Hex |~

Flot Mo.:le\LReplace v}
| oK ‘ | Cancel

il
[ 00y ]
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Simulation results are as follows

Transient Response

whdl_out

1.25470F
= 2
=

0.0

B —
1 25 TCanm_ow ==

125 JTTOURT_Gu=T=

W
/

1,25 FCORM_aW =2

G2 5 Fron_out=3=

T
25 5
time ins)

]

Transient Respanse

whdl_out
| 0 1 H 3 4
1. 25 Tend_ e ==
= .?5:
25
—.2’_
1 25 TWRdIv=1=
75
277
= 25
_.2‘7-
1. 25 PRIy =2 =
= .?5:
EET
—.2‘-
1 35 TWRA v =3=
1.254
=3
1154
1.05
1.25d7TTF
s 4
I
D."_
1.2547
g =
o
0. 04— A L R T 1
] 25 5.0 7.5
time ins}
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For more details, please check the following videos:
http://youtu.be/QzHU-FylISIo
http://youtu.be/ANG641gYyFj4
http://youtu.be/SLAEHGnrwuE

Conclusion

In this tutorial we have learned how to use AMS simulator to simulate digital
Verilog codes with digital VHDL code and analog blocks. This tutorial assumes
that, you have the AMS tool integrated with Cadence Virtuoso. For further

information, please check the video notes of this tutorial in the reference page.
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Appendix B

LOGIC SYNTHESIS

This tutorial presents the main steps to perform the logic synthesis of a digital
Verilog 4-bit counter with the Synopsys Design Vision and Design Compiler
tools. We divide this tutorial into two parts, part 1 and part 2. For part 1, we
make all the steps using the Design Vision graphical environment. For part 2, we

make the same steps using a TCL (Tool Command Language) script.

Part 1:

First step is to start the Design Vision graphical environment. In command

window type:

de_shell and press enter then type gui_start. You should get the following menu:

Design Vision - TopLevel.1
Timing Test Power Window Help

Sll@ @

Logical Hie| |Cells (Hierarchical) %

CellName _[RefName [CellPath  [D]

7| dc_shell> gui_start
de_shell>

Log | History Options: x|
de_shell> ||
‘;dy [ =3

Next step is to edit setup menu to add your target library and link library; the
libraries to which your design will be mapped. To do this step choose File->

Setup and from the following menu remove default libraries and add yours.
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Application Setup

Categories |

-Defaults

: Search path: l |
“Variables

Physical library: |

by

Link library: * P(IT/synopsys/ukGSIscllmvbbr_lZOcZS_tc.db

Target library: *FIT/synopsys/ukGSIsclImvbbr_120c25_tc.db

Symbol library: * |your_|ibrary.sdb |

Synthetic library: | |

* = required

| i

Reset vl OK I Cancel I Apply I

Z

The following step is to analyze your Verilog code to check it and see if it is
synthesizable. Choose File-> Analyze from the main menu and using the Add

button select all your Verilog sources to be analyzed then press OK.

Aﬁlyze Desiggy

File names in analysis order:

Fhome/eslam/Desktop/count4_new/count4.v

Format: IVERILOG (v) L|

Work library: | WORK LI

[~ Create new library if it does not exist

Next step is to elaborate your design. The elaboration phase performs a generic

%

pre-synthesis of the analyzed model. It essentially identifies the registers that will
be inferred.
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To do this step choose File -> Elaborate from the main menu and from the

elaboration menu select the top level file of your design and press OK as seen in

the following figure.

Library:

Design:

" Elaborate Desig'."';

| DEFAULT]| -
Il countd(verilog) 'II

Parameters: | Name

Value

v Reanalyze out-of-date libraries

After pressing OK in the elaboration menu, the main menu will be updated with

your design which is count4 in this tutorial.

Design Vision - TopLevel.1 (countd) - [Hier.1]

% Fle Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help =[]
[zRéFlaca sl onEEE|BE@E| [[ow _laaa@
7| Logical Hierarch | Cells (All) |
2 Cell Name  [Ref Name [ Cell Path | Dont Touch |
@ IO count_reg... *4SEQGEN** count_reg_r... undefined
D count_reg... **SEQGEN** count_reg_r... undefined
{D count_reg... **SEQGEN** count_reg_r... undefined
{D-count_reg... *4SEQGEN** count_reg_r... undefined
iD-add_11 *ADD_UNS_... add_11 undefined
DU **logic_1** Ul undefined
iDu2 **logic_0** u2 undefined
o1 0 GTECH_NOT 1.0 undefined
T Elaborated 1 design |
Current design is now 'countd’
dc_shell>
Current design is 'countd’.
do_shell> change_selection [get_s countd]
Loading db file ' . 09/14b: yn/g sdb’ =
il | >
Log | History Options: x|
de_shell> ||
|Ready Design | counta (=3

You can display the elaborated schematic by selecting your design in the

hierarchy window and then clicking the Create Design Schematic icon ‘& or

by right click on your design entity then choose Schematic View. The following

is the elaborated schematic view for our design.
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Edit View Select

aslzlaaa -

T Hier.1 o Schematic.2

T Elaborated 1 design. Al

Current design is now 'countd’.

de_shell>

Current design is 'countd’.

de_shell> ch election [get_s countd

Loading db file '/usr/synopsys/B-2008.09/libraries/syn/generic.sdb’ JEI
>

4

Log | History Options: x|
de_shell> ||

Click objects or drag a box to select (Hold Ctri to add, Shift to remove) ‘[Design countd 3

It is a good idea to save your design to this point. Choose File -> Save as and

from the following window choose a name and click Save.

Save Design As &l

Look in: I-J /home/eslam/Desktop/count4_new/ LI o e | E

B3..
[] countd.v

File name: | countd_elaborated.ddc|
File type: [ Database Files ( *.ddc *.ddc.gz *.db *.db.gz *.gdb ~| Cancel |

Format:  [Auto ~|  synopsys'

v Save all designs in hierarchy

You can type this command in Design Vision to generate a report of the
hierarchy of the design, report_hierarchy. You can also use this command to report

all used cells and operating voltage of your design, report_design.

Now we are going to define our design constraints like area and clock speed. For

this step select your design in the hierarchy window then click the Create

Symbol View icon ﬂ . You will get a window like this one.
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Design Vision - TopLevel.1 (count:
ign| Attributes | Schematic Timing Test Power Window Help

= Specify Clock...

Operating Environment  »
Optimization Constraints »

Optimization Directives  »

—>—clk

[Symbol.1]

count[3:0]

= Hier.1 o Symbol.1
de_shell> |
Current design is 'countd’
do_shel1> o_sole
de_she11>
do_shell> . oate_schemat
Loading db file '/usr/synopsys/B-2008.09/1ibraries/syn/generic.sdb’
de_shell> o ot x v
Log | History Options: x|
de_shell> [
Ready Port| clk =3

Now select your clock signal from the symbol view and choose Attributes ->

Specify Clock to define the clock period and its duty cycle. For our example we

choose a clock period of 10 ns and duty cycle of 50% like the following figure.

Specify Clocﬁ

Clock name: J| clk

Port name: |[clk

I~ Remove clock

—Clock creation

I~ Don't touch network

Period: § 10
Edge Value Add edge pair
Rising 0
; 5| Remove edge pair
Invert wave form
~0.00 5.00 10.

OK

I~ Fix hold

Cancel | Apply |

.
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Next step is to define the constraints on design area by choosing Attributes ->
Optimization Constraints -> Design Constraints from Design Vision main
window. We choose area to be equal to zero to get the minimum area for our

design.

~ Design Vision - TopLevel.1 (countd) - [Symbol.1]

(3 Ale Edit View Select Highlight List Hierarchy Design | Attributes Schematic Timing Test Power Window Help -[8]x

laéFlaaasa BB  Specify Clock... Jlec@
Operating Environment  »

Optimization Constraints » Design Constraints...

Optimization Directives »  Timing Constraints...

Derive Constraints.

SPPLOS

—>—clk

count[3:0]

reset

= Hier.1 o Symbol.1
i dc_shell> change_sele ot 4 ;’
de_shel1> s oate_schamati
Loading db file '/usr/synopsys/B-2008.09/libraries/syn/generic.sdb’
de_shell> o_sole jot_s clx
do_shell> croate X -name "clk” -period 10 -wavef x
1
de_shel1> c
Log | History Options: ¥|
dc_shell> [
Ready Port| clk =D

Design Consﬁlints

Current design: Icountd

—Optimization constraints

Constraint value: Unit:

Max area : IO |

Max dynamic power: I I
Max leakage power: I I
Max total power: I |

—Design rules

Max fanout: I

Max transition: |

cocer | _somy
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Next step is to compile your design. After this step your design will be mapped to
real standard cells from your target technology library. From the main window of

Design Vision, choose Design -> Compile Design, you will get a menu like the

following figure, click OK.

~ compile
—Mapping options —Compile options
[V Map design [~ Top leve I” Incremental mapping
[ :Exact map I~ Ungroup ™ Allow boundary conditi
Map effort: [medium ~|||I7 scan I Auto ungroup
Area effort:|medium | U S—  Area

—Design rule options

¢ Fix design rules and optimize mapping
¢ Optimize mapping only.

¢ Fix design rules only

" Fix hold time only

Z

4

As seen in the following figure, your design is now mapped to real standard cells.

Design Vision - TopLevel.1 (counts) - [Hier.1]

% File Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help =18]]

lzRéFlacaaul: onEEE [ BEE [l Jaeca@

? Logical Hierarchy Cells (All) =
CellName  [RefName [Cell Path  [Dont Touch |

Fd

[©count_reg..[DFQRM2RA|  count_reg_r... undefined
IDcount_reg..|DFQRM2RA | count_reg_r... undefined
[D count_reg...| DFQRM2RA | count_reg_r... undefined
[Dcount_reg..| DFQRM2RA | count_reg_r... undefined

[DU3 XOR2M2RA us3 undefined
DUs XNR2M2RA|  US undefined
ou7 XNR2M2RA| U7 undefined
DU ND2M2R v undefined
[pul0 NR2B1IM2R u1o undefined
foull INVM2R U1l undefined

count 4] <
| »

Options: v|

dc_shell> [

Ready [Design [ counta (=3

You can check the schematic view of your design now to see it in terms of

standard cells.
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T Hier.1 o Schematic.2

Log | History Options: x|
de_shell> ||
Click objects or drag a box to select (Hold Ctrl to add, Shift to remove) |Design| count4 B

A good idea is to save your design now using File -> Save As and choose an

appropriate name, for use we name it count4_clk10ns_mapped.ddc.

To report your design constraints to check if there are any violations on your
design constraints, choose Design -> Report Constraints. Continue like the

following figure.

(@ ReportConstraints g x]

—Report for

Current design: lx:ountfl

—Report options

I~ No line split I~ Verbose

I~ Show only maximum capacitance I~ Show only minimum capacitance
I~ Show only maximum delay I~ Show only minimum delay

[~ Show only maximum leakage power I~ Show only minimum porosity

I~ Show only maximum dynamic power I~ Show only maximum transition

I~ Show only maximum fanout I~ Show only maximum area
I~ Show only cell degradation I~ Show only connection class
[~ Show only multiport nets I~ Show only critical range

v Show all violators <: Significant digits: |2 3:

—Output options

v To report viewer

|17§To file:: ]count4_clklOns_mapped_aIlvioI.rpt I Browse... ]

IV Append to file

OK | Cancel l Apply ]

You will get a report like the following.
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Design Vision - TopLevel.1 (count4) - [Report.1 - Constraint]
Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help

lzRréFaca o o EEE @ = [love SJeca
=L L]
é
@ Report : constraint
-all_violators
* || Design : countd
"\ || version: B-2008.09
Date : Thu Jul 10 18:48:40 2014
max_area
Required Actual
Design Area Area
-
..... End Of Report seses
% Hier1 B Schematic.2 3 Report.1
i Design Area Area Slack |
countd 0.00 47.16 -47.16 (VIOLATED)
de_shell> =
.| I »
Log | History Options: x|
de_shell> ||
|Ready IDesign | counta (=3

This report says that, area is violated and this is expected because we set the max
area eatlier to zero to achieve a minimum area, now this minimum area can be
seen under the field of Actual Area in this report and it is 47.16 um? in our case.
Slack equals to Required Area minus the Actual Area achieved by Design
Vision, one would like always to get a positive slack. Positive slack means that,

constraint is met but negative slack means constraint is violated.

Choose Design -> Report Area to check the overall area of your design.

= Report Area '.’i_ X |

—Report for

Current design: |count4

Current instance: |

—Report options

V¥ No line split

—Output options

[V To report viewer

Vv To file: Icount4_clk10ns_mapped_area|.rp1I Browse...

v Append to file
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After clicking OK you will get a report for your design area like the following
figure.

Design Vision - TopLevel.1 (countd) - [Report.2 - Area]

“JFile Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help =[8] ]
lzrsFlecaa-ai): =260 EEE[BEE = [[cw oo
=
N 2 i
5| Xl=18 |
7 [pate  : mhu gu1 10 20:02:13 2014 |
o, ||zibrary(s) vsed:
uk651scllmvbbr_120c25_tc (File: it /hy UMC65, >_MIXED_} ,_LOW_K_|i ¥_TAPE_OUT_KIT-Ver.B02 PB/UMK65LSCLLMVBBR_B02_ TAPEOUTKI
Number of ports: 5
Number of nets: 12
Number of cells: 10
Number of references: 5
Combinational area: 15.480000
Noncombinational area: 31.680000
Net Interconnect area: undefined (Wire load has zero net area)
Total cell area: 47.160000
Total area: undefined =]
< | >
£ Hier.1 ° Schematic.2 ¥ Report.1 | Report.2 [
T Noncombinational area: 31.680000 Al
Net Interconnect area: undefined (Wire load has zero net area)
Total cell area: 47.160000
Total area: undefined
de_shell> j
Rl | | > [+
Log | History Options: x|
de_shell> |[

[Ready !Design countd B

To check timing of your design, choose Timing -> Report Timing Path.

Report Ti

from:  [pin :j| @| Selection[yl
Through:|pin _vJ| @| Selection[_Z_]l
To: pin ;” @| Selection[;]l
—Report options
Worst paths per endpoint: |1 Maximum path delay:
Max paths per group: |1 Minimum path delay:
Path type: lfull vI
Delay type: |max vl

Sort by:

I~ Report timing loops

I~ Justify paths with input vector

I~ Find true path
Igroup vI
Path delay threshold: |O
Significant digits: [2 = Z [

[~ Enable asynchronous arcs

I~ Show nets in combinational path I~ Show net transition time
I~ Show input pins in combinational path [~ Show net capacitance

I~ Show dont_touch, size_only attributes for nets and cells

—Output options

IV To report viewer

I Browse... |

Cancel I Apply I

Il7 To file: count4_clk10ns_mapped_timing.rpq

IV Append to file
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You will get a timing report like the following one; from this figure we notice that
our timing slack is positive and equals to 9.75 ns i.e. timing constraint is met and

we can reduce the required clock period by 9.75 ns. Now we know that min clock

period for our design is, 10 ns - 9.75 ns = 0.25 ns.

Design Vision - TopLevel.1 (countd) - [Report.3 - Timing]
it View Select Highlight List Hierarchy Attributes Schematic Timing Test Power Window Help

Flaan caol: - aREBEREE o Slas@

Kl | |
Log [ History Options: x|
de_shell> [

‘;dy [Design | counta =

=8
— -
LX) [ |
Z|[  count_reg regr11/0 (DFORM2RA) 0.11 PRIRE B
US9/Z (ND2M2R) 0.03 0.14 £
U10/2 (NR2BINZR) 0.04 0.17 ¢
U3/Z (XORZMZRA) 0.08 0.25 £
count_reg_reg[3]/D (DFQRMZRA) 0.00 0.25 £
data arrival time 0.25
clock clk (rise edge) 10.00 10.00
clock network delay (ideal) 0.00 10.00
count_reg_reg[3]/CK (DFQRM2ZRA) 0.00 10.00 ¢
library setup time 0.00 10.00
data required time 10.00
data required time 10.00
data arrival time -0.25
slack (MET) 9.75
% Hier.1 ] o Schematic.2 ]j Report.1 ]j Report.2 ] Report.3 I—
data arrival time -0.25 |
ezl
de_she1l> =
»

A good way to visualize your timing paths and determine the critical path can be

done using Timing -> Path Slack. Choose OK from the following menu.
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Path Slack i"]

From:  [pin :“ @lSelection[y

Through: [pin :” 25 ] Selection[2]

To: Ipin :” %}l Selection[3]

Nworst paths:l 10 3: Max paths: ISO 3:
Group name: I vl Delay type:lmax vl

" Enable preset clear arcs ¥ Include hierarchical pins

¢ Number of bins: |8 3:

¢ Value range per bin: |

<= Slack <= |

I~ Lower bound strict " Upper bound strict

Histogram title: |Path Slack

X-axis title: |Slack

Y-axis title: INumber of Paths

Cancel | Apply |

You will get a histogram for slacks of all timing paths in your design like the

following one.

Design Vision - TopLevel.1 (countd) - [HistList.1 - HistList.1 Path Slack]

ndow Help

& File Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power

lzrgFlea@acan]* [t =aE|EE0E B[~ Sl
N Path Slack

e 10

©

@,

Q,

O

Number of Paths

lo.8
Stack
Worst Best
9.74757 | 9.87152
EY Hier.1 o Schematic.2 =2 Report.1 ] Report.2 [ Report.3

>3] HistList.1

do_shell> change_selection [get_s countd]
dc_shell> chang oction
ection [get_s countd]

dc_shell> change_selection [get_s countd]

« |

A

Log | History Options: x|
de_sheli> ||
Ready [path .| (Gount_reg_real310} | m>
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In this histogram, the path with the smallest slack is the worst (critical) path in
your design. In our example, the worst paths have a slack of 9.74 ns. When
selecting any path from this histogram you can see the equivalent path on your

circuit by moving to your schematic view. The selected path above is shown in

schematic as follows.

Design Vision - TopLevel.1 (count4) - [Schematic.2]

o Fle Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help

SPRENE]

HE |y |leaasad| | (= e e E S

[[[counta

Fl@s@

o Schematic.2 T ] Report.3 HistList.1
&
dc_shell>
4 - - - ;[E]
Log | History Options: x|
de_shell> [

Click objects or drag a box to select (Hold Ctrl to add, Shift to remove)

[Path .. Tcount_reg_reql31D} | m»

Other reports can be useful for you like resources report, you can get it from

Design -> Report Design Resources as following,.

Report Design Resoﬁes

—Report for

Current design: |count¢l

Current instance: |

—Report options

[17 No line splitl [V :Show resources for subdesigns

—Output options

V' To report viewer

IV To file: Iunt4_c|klOns_mapped_resources. Browse...

v Append to file
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In the following steps, we will export the netlist file and all needed files to be used
in the following design stages like automatic place and route using SOC

Encounter.

Before exporting the netlist file you have to type the following command in
Design Compiler command line.

change names -rules verilog -hierarchy -verbose

This command is to apply some verilog naming rules to your design before

exporting the gate level netlist file.

Design Vision - TopLevel.1 (countd) - [Report.4 - Resources]

"] File Edit View Select Highlight List Hierarchy Design Attributes Schematic Timing Test Power Window Help =18 X
lzagFlaaa-a@]* * EEE EEEE [ s

—— =

L xl=lal ®[

) a]
@l res | DWO1_inc | width=4 1 | add_11 1

*||No implementations to report

No multiplexors to report

Design Type Object New Name

countd cell count_reg_reg[0] count_reg_reg 0_

countd cell count_reg_reg(1] count_reg_reg_1_

count4 cell  count_reg reg(2] count_reg_reg_2_

countd cell count_reg_reg(3] count_reg_reg_3_

Information: Defining new variable 'var Messages’

Information: Defining new variable 'max_model_: '. (CMD-041)

Information: Defining new variable ‘collection_deletion_effort'. (CMD-041)

..... End Of Report s+ees

T Hier.1 Jo  schematic2  |[J Report.1 [¥] Report.2 %] Report.3 & HistList.1 ) Report.4

cell  count_reg_rog[3] count_reg_reg_3_

on: Defining new variable 'var Messages'. (CMD-041

Defining new variable 'max model_depth'. (CMD-041

on: Defining new variable 'collection deletion_effort'. (CMD-041

dc_shell>
k1| ]

Log | History Options: x|
dc_shell> |cb.ng-_n--u -rules verilog -hierarchy -v-xbﬂ"” <;:

[Ready [path .. Tcount reg_regi31) | &

E'_L L ‘!m

Now, save your netlist verilog file using File -> Save As then type an appropriate

name and change the format to verilog like the following figure.

Save Design As

Look in: |3 /nome/eslam/Desktop/count4_new/

] count4_elaborated.ddc
[ countd.v

File name: || countd_cik10ns_mapped.v |

File type: | Database Files ( *.ddc *.ddc.gz *.db *.db.gz *.gdb ¥| Cancel |
Format: 'VERILOG (v) Q SYNoPsys'

v Save all designs in hierarchy

Z.
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The output gate level netlist file from this step is as follows.

module count4 ( clk, reset, count );
output [3:0] count;

input clk, reset;

wire nl, n2, n3;

wire [3:0] count_next;

DFQRM2RA count_reg_reg 0_ (.D(nl), .CK(clk), .RB(reset), .Q(count|0]) );

DFQRM2RA count_reg_reg 1_ (.D(count_next[1]), .CK(clk), .RB(reset), .Q(
count[1]) );

DFQRM2RA count_reg_reg 2 (.D(count_next|2]), .CK(clk), .RB(reset), .Q(
count|2]) );

DFQRM2RA count_reg_reg 3 (.D(count_next[3]), .CK(clk), .RB(reset), .Q(
count|3]) );

XOR2M2RA U3 (.A(count[3]), .B(n2), .Z(count_next[3]) );

XNR2M2RA U5 (.A(count|2]), .B(n3), .Z(count_next[2]) );

XNR2M2RA U7 (.A(count[1]), .B(nl), .Z(count_next[1]))

ND2M2R U9 (.A(count[1]), .B(count[0]), .Z(n3) );

NR2B1M2R U10 (.NA(count[2]), .B(n3), .Z(n2));

INVM2R U11 (.A(count|0]), .Z(nl) );

endmodule

b

This file will be used in appendix C and is also used as an input to the automatic

place and route tool, SOC Encounter to generate the layout for your design.

Next step is the post synthesis timing data extraction. In this step we extract the
standard delay format file which can be used in post synthesis simulation. To get
this file, type the following command in the command line of Design Vision.
write_sdf -version 2.1 coun4_clk10ns_mapped_vlog.sdf

You can fine this file and all report files you’ve generated earlier in your working

directory.

The following command is to generate a file includes all your design constraints
in TCL format and will be used in standard cell placement and routing (SOC
Encounter).

write_sdc -nosplit count4_clk110ns mapped.sdc
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For more details, please check the following video:

http://youtu.be/pD85Hnsi2cc

Part 2:

The same steps of part 1 can be done by using this TCL script. The code is self
documented, please read it carefully and edit all needed fields according to your

design.

# Design Setup (change library files according to your technology)

set link_library /home/eslam/Desktop/synopsys/uk65lsclimvbbr_120c25_tc.db

set target_library /home/eslam/Desktop/synopsys/uk65Isclimvbbr_120c25_tc.db
#Analyze

analyze -format verilog {/home/eslam/Desktop/synopsys/count4.v}

#elaborate (count4 is the name of the top level module)

elaborate count4 -architecture verilog -library DEFAULT -update

write -hierarchy -format ddc -output /home/eslam/Desktop/synopsys/count4.ddc
#timing & area constraints (clk is the clock name in my verilog file-edit according to
your design (ns))

create_clock -name "clk" -period 10 -waveform { 05 } {ck }

set_max_area 0

#compile design

compile

#export design (reports and netlist and timing files)

write -hierarchy -format ddc -output
/home/eslam/Desktop/synopsys/count4_clk10ns_mapped.ddc

#generate design reports

report_constraint -nosplit -all_violators > /home/eslam/Desktop/synopsys/allviol.rpt
report_area > /home/eslam/Desktop/synopsys/area.rpt

report_timing > /home/eslam/Desktop/synopsys/timing.rpt

report_resources -nosplit -hierarchy > /home/eslam/Desktop/synopsys/resources.rpt
report_reference -nosplit -hierarchy > /home/eslam/Desktop/synopsys/references.rpt
report_hierarchy > hierarchy.rpt

report_design > design.rpt

#add some verilog naming rules before exporting the gate level netlist file
change_names -rules verilog -hierarchy -verbose

write -hierarchy -format verilog -output
/home/eslam/Desktop/synopsys/count4_clk10ns_mapped.v

write_sdf -version 2.1 count4_mapped_vlog.sdf

write_sdc -nosplit count4_vlog.sdc

puts "Finished"
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http://youtu.be/pD85Hnsi2cc

For more details, please check the following video:

http://youtu.be/gH6ZMh3IQBI

Conclusion

Using this tutorial we’ve learned how to convert our functional verilog code into
a gate level netlist file, i.e. a file containing standard cells from our technology
library and learned how to define design constraints like timing and area
constraints and how to analyze timing paths using a timing histogram and finally
how to generate all needed reports and files which can be used in next design

steps like automatic place and route.
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Appendix C

IMPORTING SYNTHESIZED DESIGN INTO CADENCE COMPOSER

SCHEMATIC VIEW

In this tutorial we are going to simulate a digital 4-bit Verilog counter to test its

function first without any timing analysis then we will use the synthesized version

(output of Design Compiler) of this counter and import it into CADENCE

Composer as a schematic view containing all standard cells needed for this

counter from our technology library, so in this part we will simulate the 4-bit

counter in two levels of design:

1. Pre-synthesis functional Verilog simulation using AMS simulator

2. Post-synthesis transistor level simulation using Spectre simulator

1. Pre-synthesis functional Verilog simulation using AMS simulator

The following is the digital 4-bit Verilog code used for this tutorial:

module count4(input clk,reset,output[3:0] count);
reg[3:0] count_reg;
wire[3:0] count_next;

//state register

always@(posedge clk,negedge reset)
if(~reset)

count_reg <= 0;

else

count_reg <= count_next;

//next state logic

assign count_next = count_reg+1;
//output logic

assign count = count_reg;
endmodule

For this tutorial, we will make new work library and name it post_synthesis as

following:
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LiBrary Manage?wafmrea: /usr/local/]éélci/{'sMC_SSnm

M Edit View Design Manager Help

cadence

Wi Library.

Open. Ctrl+O
Open (Read-Only), Ctrl+R

Cell

Open With,

Load Defaults...
Save Defaults...

Open Shell Window...  Ctrl+P

Exit Cirl+X

[Tambit

ams_mapped
ams_tutorial
analogLib

hasic
cdsDefTechLib

cds_assertions
cds_inhconn
cds_spicelib

connectliby
functional
ieee
ncinternal
nemadsle

Messages

LIB connectLib from the same file (defined earlier)

Warning: LIB connectLib from File fusr/local/IC614/TSMC_B5nm/cds.lib Line 18 redefines
LIE connectLib from File /ust/local/ICE14/tools.Inx86/affirma_ams/etc/connect_lib/cds.lib

Insert UNDEFINE connectLib
hefore DEFINE connectlib

in fusrflocal/ICB14/TSMC_BSnm/icds.lib

Or remove or comment out DEFINE connectLib

in fusrflocal/ICB14/tools Inx86/affirma_ams/etc/connect_lib/cds lib

to suppress this waming message.
el S £

IS

_____ ™
%

Library

New Libra

Name Ipast_synthesis I @

Directary |3 fusr/local/ICE14/TSMC_BSnm/ ' (=]

(3 Asssura
accl
3 cCalibre

S Play

([ Techiile

) adpll_mixed
) adpll_mixed?2

) NangatePfdLoopF

(AUMKBSFDKLLCO0000OA_B10

&) ams_mapped (A nandz_run1

) ams_tutorial (I nandz_testru
(Jdrc_B5Sn (dnandz_test_n
(Qinv_hdl_thrun1 I notgate_th_r.
(Qinv_hdi_tb_run (I notgate_th_r.
(Qinv_hdi_tb_run1 [Jnotgate_th_vI
(inv_hdl_th_runz Q) pfd_loopF_vi
(3 Ivs_BSnm [ skill

(O models S test

(I nandz.run1 Qtsme13rf

[ S
o [ |

File type: Directories Ed
Design Manager
® Use NONE
Use Ko Di
Apply Cancel Help
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Technology File for library "post_synthesis"

You can: « Compile an ASCIl technology file
 Reference existing technology libraries
& Attach to an existing technology library

« Do not need process information

Cancel /| Help
e

We should attach this work library to our technology library which is umc651l in

our tutorial.

Attach Lriibriary to Technolr'.’.viLriib’ra;y

MNew Library post_synthesis

Technology Library analogLih
basic
cdsDefTechLib
tsmcl3rcf

tamcN6S

Cancel /| &pply Help

We make similar steps to those done in appendix A to import this Verilog code

into cadence as following:

-

B New , [Area: /usr/local/IC614/TSMC_65nm ﬁj - o x
File Edit View  Open. cadence
EDIFz00...

_ Show Categ Export » —

: Refresh. .. anog. <—1
Library VHDL View
e e Make Read Only... SRR
post_synthesis Spice...
ams_tutorial Byokmarks » DEF...
zgiilcongb <& 1 ams_mapped pfd_loopF schematic LEF...
cdsDefTechLib E 2 adpll_mixed2 allDesign config olfEalt;
cds_assertions - Netlist View...

= <& 3 adpll_mixedZ allDesign schematic
cds_inhconn
cds_spicelib |4 4 adpll dco2_tb schematic
connectLib ® 5 ams_mapped loopFilter_0 schematic
functional
ieee & 6 ams_mapped pfd schematic
neinternal <& 7 ams_mapped countd schematic
ncmodels
neutils <& 3 adpll_mixed all_vlog schematic
[LECIGEREN & 3 adpll ring_osc_th schematic
MExamples
MLib <& 0 adpll ring_osc_nohdc schematic
sdilib -
st Close Data...
Exit...
Messages Tools Options Sonnet Help cadence
I\;\:’Barﬁﬁ'}r:;?_[l:gi Loading umc6511/1ibInitCustomExit. il ... Loading context 'oxf_ch' from library 'umcé
: | done!

:‘IB ?tULTlTJ%CFEﬂf_:'I Loaded umc6511/1ibInit. il successfully! e
l;]esfire DEFIN INFO (TECH-180011): Design library 'post_synthesis' successfully attached to technology library 'umc’=

in fusrfiocal] - [ Il D -
Or remove or —

in fusrflocall =

A | limouse L: M: R:

1| verilog...
I | P
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= \7/efiAIhog In i'] X

Import Options Global Net Options Schematic Generation Options

File Filter Name

COunta. ve
countd mapped. v
countd mapped. v

v /home feslam/Desktop/countd /

Target Library Name post_synthesis| [ Browse |

Reference Libraries basic

Yerilog Files To Import ‘home feslam/Desktop/countd /countd. v Add

-f Options \ Add

-y Options  Add
Nt/

-y Options . Add
ity

Library Extension

Library Pre-Compilation Options

Pre Compiled Verilog Library

HDL View Name hdl

Target Compile Library Name | Browse

Compile Verilog Library Only

Ignore Modules File Add
Import Modules File Add
Import Structural Modules &5 schematic

Structural View Names

" ‘

Cancel ;. Defaults | Apply | Load | Save )| Help

-

After ending this process, you will get a functional and symbol view for your

counter.
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File Edit View Design Manager Help cadence
_ Show Categories __ Show Files
- Library Cell View Y
‘ post_synthesis| countd
e o Tnclona ‘
analogLib symbol
hasic
cdsDefTechLib
cds_assertions
cds_inhconn
cds_spicelib
connectLib
functional
ieee
ncinternal
ncmodels
ncutils
i
HExz neutils
Lib
sdilib
std =i |
.~ Messages
LIB connectLib from the same file (defined earlier.)
Warning: LIB connectLib from File fust/local/IC614/TSMC_BSnm/cds.lib Line 18 redefines
LIB connectLib from File fusr/local/ICB14/toals. Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
before DEFINE connectLib
in fust/local/ICE14/TSMC_BSnm/cds.lib
Or remove or comment out DEFINE connectLib
1n fusrflocal/ICB14/tools.InxG6/affirma_ams/etc/connect_lib/cds.lib )
7.
Double click on functional view to check your code.
r 1
5] Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm ﬁj P
File Edit View Design Manager Help cadence
verilog.v (/usr/local/IC614/TSMC_65
— Show Categoril File Edit View Search Tools Documents Help
.~ Library View
[ || &3open v : vil ‘
post_synthesis functional
ams_tutorial | ) verilog.v X I | [ |
logLib T T hol
gg;gg ! 1|// created by ihdl ambo
cdsDefTechLib 2 module count4(input clk,reset,output[3:0] count);
cds_assertions 3 reg[3:0] count_reg;
cds_inhconn 4 wire[3:0] count next;
cds_spicelib 5 //state register
connectLib 6 always@(posedge clk,negedge reset)
functional 7 if(~reset)
ieee -
neinternal 8 count_reg <= 0;
ncmodels 9 ElSE
neutils |16 count_reg <= count next;
[TESTGEEEE |11 //next state logic
HExamples |12 assign count _next = count reg+l;
riLib 13 //output logic
sdilib |14 assign count = count reg;
sid |15 endmodule
16
> Verilog v  TabWidth: 8% Ln1,Col 1 INS
LIB connectLib fr

7
Warning: LIE connectLib from File fust/local/IC614/TSMC_B5nm/cds.lib Line 18 redefines
LIE connectLib from File /ust/local/IC614/tools.InxG6/affirma_ams/etc/connect_lib/cds lib
Insert UNDEFINE connectLib
before DEFINE connectLib

in fustflocal/ICB14/TSMC_B5nm/cds.lib
Or remove or comment out DEFINE connectLib

1n fustilocal/ICB14/00ls.InxB6/affirma_ams/etc/connect_lib/cds.lib

A 1l

Now, it’s time to make a test bench for this code to generate simulations results

for it.
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File

Library post_synthesis n
Cell countd thi

View 3 ::Vhema.t.irx:

Type schematic

Application

Open with Schematics L n
_ Always use this application for this type of file

Library path file
fusr/local /IC614 /TSMC_65nm/cds. 1ib

m ;Crancel' »Helrp

Launch File Edit View Create

cadence

mouse L: schSingleSelectPt()
6(15)

M: schZoomFit{1.0 0.9) R: schHitMousePopUp()

| cmd: sel: o

For this code we use an active low reset signal, this is how to get this reset signal

using library sources:
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] Add Instanceﬁ X

Likrary analogLihb Browse

Cell vpwl

View symbol

Names

Array Rows 1 Columns 1

42 Rotate | | Ak Sideways | | Upside Down

1l

Freguency name for 1/period

Number of pairs of points 3

Time 1 0Ds

Voltage 1 E |
Time 2 In s

Voltage 2 0

Time 3 l.In's

Voltage 3 1.2 v |

Noise file name [

Number of noiseffreq pairs 0

DC voltage

&C magnitude

AC phase

AF magnitude

PAC magnitude

m Cancel /| Defaults /| Help

Use similar steps to that in appendix A to create new config view for your test
bench and don’t forget to change the simulator to AMS and edit the connection

rules.
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7- " New r'-=|a X

File
Library post_synthesis [~ |
Cell countd th|
View config
Type config [~ ]
Application
Open with Hierarchy Editor '
— Always use this application for this type of file

Library path file
fusr/local /IC614 /TSMC_65mm/cds. 1ib

Cancel Help

'- Choosiing Siimlvjrlat’orliDirectory/Host -- \iirturi'i@ Anélbg Des x

Simulator ams

&D3Ssim
Project Directory aps

hspiceD
Host Mode spectre  distributed

UltraSim
HOSTO N i ===
Remote Directory ~ spectreVerilog

' Ultrasim¥erilo
ED Cancel Defaults Apply Help

You must start the simulation from this config view as we noticed in appendix A.

The simulation results for this Verilog 4-bit counter are in the following figure:
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2. Post-synthesis transistor level simulation using Spectre simulator

Now, we are going to import our synthesized Verilog code (standard cells
description of our counter — output of Design Compiler) into CADENCE
composer and simulate it in the transistor level using Spectre simulator. We use
similar steps as we did to import the functional Verilog code but the only
different part in import menu is that, you must specify your standard cells library

(for us, it is umc65stdcells ) as shown in the following figure :
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Ve r:iﬂlgg in

Impart Options Glohal Net Options Schematic Generation Options

File Filter Name

v /home feslam/Desktop/countd

Target Library Name post_synthesis " Browse

Reference Libraries basic fmceSstdcells |<:=

Verilog Files To Import lam/Desktop/countd /countd mapped. v L add J

-f Options Add
-y Options . Add
N it/
-y Options add
Naiansiny/
Library Extension
Library Pre-Compilation Options
Pre Compiled Yerilog Library
HDL View Mame hdl
Target Compile Library Name i —
Compile Verilog Library Only
Ignore Modules File Add
Import Modules File Add
Import Structural Modules &s  schematic

Structural View Names

R ‘

Cancel ;. Defaults | Apply )| Load )| Save | Help

-

Transistors used in each standard cell in umc65stdcells are taken from the
technology library we’ve included earlier, the umc65ll. You can have a look on

the mapped code of this counter in the following figure:
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module count4 ( clk, reset, count );
output [3:0] count;

input clk, reset;

wire nl, n2, n3;

wire [3:0] count_next;

DFQRM2RA count_reg_reg_0_ ( .D(n1), .CK(clk), .RB(reset), .Q(count[0]) );

DFQRM2RA count_reg_reg_1_ ( .D(count_next[1]), .CK(clk), .RB(reset), .Q(
count[1]) );

DFQRM2RA count_reg_reg_2_ ( .D(count_next[2]), .CK(clk), .RB(reset), .Q(
count[2]) );

DFQRM2RA count_reg_reg_3_ ( .D(count_next[3]), .CK(clk), .RB(reset), .Q(
count[3]) );

XOR2M2RA U3 ( .A(count[3]), .B(n2), .Z(count_next[3]) );

XNR2M2RA U5 ( .A(count[2]), .B(n3), .Z(count_next[2]) );

XNR2M2RA U7 ( .A(count[1]), .B(n1), .Z(count_next[1]) );

ND2M2R U9 ( .A(count[1]), .B(count[0]), .Z(n3) );

NR2B1M2R U10 ( .NA(count[2]), .B(n3), .Z(n2) );

INVM2R U11 ( .A(count[0]), .Z(n1) );

endmodule

After ending this process successfully, there will be a schematic view added to

your cell views of the counter.

Library Manager: WorkArea: /usr/local/IC614/TSMC_65nm

File Edit View Design Manager Help cadence

— Show Categoties __ Show Files
- Library cell View

post_synthesis count4 schematic

functional count4 functional
ieee
ncinternal
ncmodels
ncutils
HExamples
rLib

sdilib

std

SYNnopsys
tsme1 3t
tsmcNBS
tutorial
umcBSsl
umcBSstdcells
verilog
vital_memory

symbal

.~ Messages

Warning: LIB conneciLib irom File 7usiIocaliCB147TsMC_Bonm/cds b Line 16 redennes
LIB connectLib from File fust/local/ICB14/tools.Inx86/affirma_ams/etc/connect_lib/cds.lib
Insert UNDEFINE connectLib
hefore DEFINE connectLib

in fust/local/ICB14/TSMC_BSnm/icds.lib
Or remove or comment out DEFINE connectLib

in fusr/local/ICB14/tools.Inx86/affirma_ams/etc/connect_lib/cds.lib
to suppress this warning message.

-

= - > M

Qo

Double click on this schematic view to check the internal structure of your

counter in terms of your standard cells.
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Virtuoso® Sche

Launch File Edit View Create C ons re UMC Utils Help

(&‘c\‘;‘\&i

mouse L: schSingleSelectPt() M: schZoomFit{1.0 0.9)

R: schHiMousePopUp()
5@ | >

| Cmd: Sel: 0

You can also check the internal structure of each standard cell in your counter by

pressing shift+E on this cell. The following are the internal structures of two

standard cells used in this counter:

Launch File Edit View Create Check Options Migrate Window Calibre UMC Utils Help

} ( I B 3 5 A
| ‘ @ T, & QQ & &
® countd | ® U3 (NDZMZR)

mouse L: schSingleSelectPt() M: schHiDescendRead()

R: schHitMousePopUp()
3@ | >

| Cmd: Sel: 0
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Launch File Edit Yiew Create Check Options Migrate Window Calibre UMC Utils Help céuen(e

| I @ T2 £ QQ & & | B

& countd - U3 (XORZMZRA)

mouse L: schSingleSelectPt() M: schHiDescendRead{) R: schHitousePopUp()
39| = | Cm: Sel: 0|

Now, it is time to test this schematic. An important notice here is that; don’t
forget to connect power nodes (VDD and GND) and bulk nodes of transistors
(VBN and VBP). We did not make this step when simulating the functional
Verilog code because there were no transistors in this schematic and we were just

simulating the code.

The simulation results for the transistor level schematic of the counter are in the
following figure. One can easily notice, the same output as the functional Verilog

code is achieved.
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For more details please check this video:

http://voutu.be/FIjRAZzKSvxc

3. Conclusion

In this tutorial, we have simulated a digital Verilog 4-bit counter in two different
design levels, one is to simulate the pre-synthesis Verilog code to test its
functionality only and another one is to simulate the post-synthesis code after
being mapped to real standard cells from your technology library. Both

simulations give the same results.
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Appendix D

STANDARD CELL PLACEMENT AND ROUTING

In this tutorial we will learn how to import the gate level netlist file (which we get
from SYNOPSYS Design Vision) into CADENCE SOC Encounter to do the
placement and routing of the standard cells used in our example, the 4-bit
counter. You may import the final layout from this step into CADENCE layout
editor to check it through DRC, LVS and PEX and make the post layout
simulation. The tutorial is divided into two parts, part 1 and part 2. For part 1 we
make all the steps using the graphical environment and for part 2, we make the

same steps using a TCL (Tool Command Language) script.
Part 1:

The starting window for SOC Encounter looks like the following figure.

Design Edit Synthesis Partition Floorplan Power Place Clock Route Timing S| Yerify Tools Help cadence

E—

-~ B“f\
£ All Colors

IElaqadoohdar|&
In &% @] 1R ) %] =] 5] 5

| ® & @ 0| ED . & ||Designis: Notin Memory

B R
FPlan View
Module

Fence

Guide

Obstruct [ |
Region

Area Density
Instance

Std. Cell
Cover Cell
Block

10 Cell

Area |O Cell
Net

Special Net
Terminal
Ruler

Text

Rel. FPlan
vield Cell [
vield Map [
SDP Connect &
Density Map [

. H H N EE NN N N

O

WOE N W N NN NN N NN NN NN N<

-4

J o 0(  -0102,  0.014)
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Choose Design -> Import Design, the following window will show up. Fill it
with your gate level netlist in the field of Verilog Netlist then choose your
Timing Libraries as follows, for Max Timing Libraries choose the file with
worst case conditions and for Min Timing Libraries, choose the file with best
case conditions and finally for Common Timing Libraries, choose the file with
typical case conditions. For LEF files you need to add the LEF files from your
technology kit. For Timing Constraints File, add the SDC file which we got

from Design Vision in logic synthesis step.

Desi_gn Import

| gﬂm@eﬁ’v]

I— Verilog Hetlist:

Files:Icount4_clk1Uns_mapped.v
Top Cell: F Auto Assignlv By User:

' — Timing Libraries:
| Max Timing Libraries:f/mnt’hgfs/UMCES/G-ILT-LOGIC_MIXED_MODEBSN-LL_LOW_K ...

Min Timing Libraries: /anhgfs!UMCBS/G-SLT-LOGIC=MIXED=MODE65N-LL&K
Common Timing Libraries: l(mnﬂhgfs."UMCBS/G-9LT—LOGIC_MIXED_MODE65N-LL_LOW_k

LEF Files: {PB/UMKBSLSCLLMYBBR_B0Z_TAPEOUTKIT/leffukBSisclimvhbbrlef ...
Timing Constraint File: flcountd_clk110ns_mapped.sdc
10 Assignment File: =]

oK Save.. Load... I Cancel | Help

Now move to the Advanced tab and choose Power to add names for your
power nets, make sure to type proper names like in you LEF file. To know the
power net names in your technology kit you can check the LEF file and search
for "power" to know the name for power net and ground net. For our
technology library, net names are VDD and VSS. You may need to save this
configuration to use it again instead of inserting all fields from the beginning, to

do this step choose Save and the OK.
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Design Import

<=

Delay Calculation Al Power Nets: VDD

I(IB_EAS Ground Nets: [vVSg
IPO/CTS Toggle Rate Scale Factor: | 1.0

OpenAccess
Power <_|
RC Exiraction
RTL

Sl Analysis
Timing

Yield

MMMC

=l

oK Save... Load... | Cancel | Help

It is a good idea to save your design using Design -> Save Design As -> SoCE.

Next step is to specify the floorplan for your design, choose Floorplan ->
Specify Floorplan. Define an aspect ratio of 1 and core utilization of 85%
which means that 15% of the core area will be free for possible future cell
replacements. Choose core to die boundary large enough to hold the power
rings, we choose it as 0.6 microns. This is enough for this design as there will be
one power ring and one ground ring of 0.1 micron and spacing between them of

0.1 micron also.
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Speciﬁt Floorplan

Basic

— Design Dimensions

Specify By: 4 Size -« Die/IO/Core Coordinates

% Core Size by: @ Aspect Ratio: Ratio (H/W):10.97297237

@ Core Utilization: | 0.885135
~ Cell Utilization: | 0.835135
~ Dimension: 74
: 7.2
~ Die Size by: Widtt 5.6
a4
Care Margins by: . Core to 10 Boundary
|# Core to Die Boundary

Coretoleftf 0.6 Core to Top:
Coreto Right] 0.6 Core to Bottom:

1] T

IO Box Calculation Use: s Max 10 Height 4 Min IO Height
Floorplan Origin at: @ Lower Left Corner - Center
Unit: Micron

OK I Apply I Qancell Help I

Your floor plan will look like the following one.
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SoC Encounte|
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Choose Floorplan -> Connect Global Nets to connect power nets to your
design. From the following menu type VDD in pin name and VDD in the field
of To Global Net then click on Add to List. Make similar steps for VSS then
Apply and Close this window.

‘Ai Global Net Connections ﬁ e |

Connection List T Powser Ground Connection

Connect
4 Pin
. Tie High
, Tie Low
Instance Basename:|*

Fin Nae(s)

Net Basename: |

Scope =
, Single Instance: |
@ Under Module:
, Under Power Domain: |
Under Region: | [0.0° 11 [0.0 [oo v fon
- Apply Al

To Global Net{vDD| |

| Override prior connection
W Verbose Output]
] Add to List Update | Delete

Apply | Reset Close Help
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In the command window you will get a report of these connected power pins like

the following figure.

root@local host:/home/eslam/Desktop/count4_encounte'i=|

File Edit View Search Terminal Help

Saving route ...
*** Completed saveRoute (cpu=0:00:00.0 real=0:00:00.0 mem=196.5M) ***
*** Completed saveYieldMap (cpu=: 0:00:00.0 real=0:00:00.0 mem=: 0.000M) ***
Creating constraint file...
encounter 1> Writing Netlist "/home/eslam/Desktop/count4 encounter/count4-clklen
s-import.enc.dat/count4.v" ...
Saving configuration ...
Saving preference file /home/eslam/Desktop/count4 encounter/count4-clkl@ns-impor
t.enc.dat/enc.pref.tcl ...
Saving SI fix option to '/home/eslam/Desktop/count4 encounter/count4-clk1lOns-imp
ort.enc.dat/siFix.option'...
Saving floorplan ...
Saving Drc markers ...

. No Drc file written since there is no markers found.
Saving placement ...
*** Completed savePlace (cpu=0:00:00.0 real=0:00:00.0 mem=196.5M) ***
Saving route ...
#*+ Completed saveRoute (cpu=0:00:00.0 real=0:00:00.0 mem=196.5M) ***
**% Completed saveYieldMap (cpu=: 0:00:00.0 real=0:00:00.0 mem=: 0.000M) ***
Creating constraint file...
encounter 1> encounter 1> encounter 1> encounter 1> encounter 1> encounter 1> en—
counter 1> 10 new pwr-pin connections were made to global net 'VDD'.
10 new gnd-pin connections were made to global net 'VSS'.

B

Next step is to add power rings to your design. To do this, choose Power ->
Power Planning -> Add Rings and the following window will show up. From
this window, choose the width of your power rings and the spacing between

them.
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Add Rings X
Basic || Advanced | Yia Generation |

Net(s): [VSS VDD
Ring Type
4 Core ring(s) contouring

4 Around core boundary ~ Along /O boundary

| Exclude selected objects
+~ Block ring(s) around
.~ User defined coordinates:
Ring Configuration

Top. Bottom: Left: Right:
Layer: MET H «| METH - MEZ ¥V | MEZV
Width: 0.1 0.1 0.1 0.1
Spacing: §0.1 0.1 0.1 0.1 Update
Offset: [ Center in channel - Specify
[0z oz oz "oz
Option Set
Variables Apply Defaults Cancel | Help

Your floorplan will now look like the following one.
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Save your design to this point using Design -> Save Design AS -> SoCE and

choose an appropriate name, we choose count4_clk10ns-pring.enc.

Now, it is possible to route the power grid. Select Route -> Special Route then

clock OK. After this step you will get the following.

F ol
i} SoC Encounter(TM) RTL-to-GDSII System 8.1 - /home/eslam/Desktop/count4_encounter - counté“»"ﬂ - EX
Design Edit Synthesis Parition Floorplan Power Place Clock Route Timing 351 Verify Tools Help cadence

A o , = | @ A = e & S

J BlQ& @ B—l QOB B va“‘? | ® & O | B M & & ||Designis:  In Memory oo i

olors

FEE

I ook o) )@ )% B 1| B s] 6| =] & 1y B

FPlan View
Module

Fence

Guide

obstruct [l
Region

Area Density
Instance

Std. Cell
Cover Cell
Block

10 Cell

Area |O Cell
Net

Special Net
Terminal
Ruler

Text

Rel. FPlan

e R R R R R ERSER®B}

O

L W E NN NN NN NN NN <

SDP Connect W
Density Map [

J Q (4898,  6.042)]

Next step is to add well taps to your design so that your VDD and GND are
connected to substrate and n-wells respectively. This is to help tie them to your
VDD and GND levels so that they don't drift too much. Choose Place ->
Physical Cells -> Add Well Tap. Choose the well tap from your technology
library and click OK.
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Add Well Tap Instances ﬁ

Cell Name “?'WTSIR’  Select
Max. Gap hetween Cells along Row (10
Fixed
Offset from Start of Row for First Cell in Row (0.0
Number of Site Rows to Skip for Next Row of Cells |0
Row Number to Start Adding Cells N
Prefix [WELLTAP
1 Fill Area

oK Apply Cancel Help \

. <
= SoC Encounter(TM) RTL-to-GDSII System 8.1 - /home/eslam/Desktop/count4_encounter - count4’5 - O x

i
5]

Design Edit Synthesis Parition Floorplan Power Place Clock Route Timing S| Verify Tools Help (éden(e

|

o o @ 73 - = o o @~ |z = TR
J; QLA OO |8 & | vg“f 9 ‘ ®&£00EE & ||Designis:  In Memory i ‘

J A8
| 18| b W) =] | ) ) [T

FPlan View
Module

Obstruct [l

Area Density
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Std. Cell
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10 Cell

Area 10 Cell
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Special Net
Terminal

Ruler

Text

Rel. FPlan

vield Cell [
S vield Map [
SDP Connect
Density Map ]

e R R R R R REREBJE

IERREE R R RERRERENREE NS
|

|-

J Inst: WELLTAP_27 Q 1( 6.346, 6.617)} B

Next step is placing the standard cells. Choose Place -> Standard Cells and

check the following menu then click OK.
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# Run Full Placement - Run Incremental Placement - Run Placement In Floorplan Mode |

Optimization Options-
W Include Pre-Place Optimization
B Include In-Place Optimization

Number of Thread(s): |1 Set Multiple CPU... |

oK Apply i Mode [ Qefaults] Cancel ’ Help

Your standard cells are now placed and you can check them.

DSII System home/eslam/Desktop/count ol E

Design Edit Synthesis n Floorplan Power Place Clock Route Timing S Verfy Tools Help cadence

IElaQa@ooda-|&d|s ¢« | @& 0| FE& & |pesins:
' | g ['%T i i

[

All Colors

FPlan View
(Module
Fence
Guide
obstruct [l
Region
Area Density
Instance f
Std. Cell
Cover Cell
Block
10 Cell
Area |0 Cell [
Net
Special Net
Terminal
Ruler
Text
Rel. FPlan
Yield Cell
g Vield Map [
,,,,,,,, X £y SDP Connect @
I ' Density Map n Jd

WO OW NN NN NN

O

R ERREERRRERRERRE R ERE IS
W

i
T

untireq yeq: 0

[ Place

4 Run Full Placement - Run Incremental Placement - Run Placement In Floorplan Mode |

Optimization Options-
® Include Pre-Place Optimization
M Include In-Place Optimization

Number of Thread(s): |1 Set Multiple CPU... ]

oK Apply ( Mode [ Qefaults‘ Cancel Help
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After clicking OK we got these violations, there was an overlapping between

some standard cells.

SoC Encounter(TM) RT
Design Edit Synthesis Pari

n Floorplan Power Place Clock Route Timing S| Verify Tools Help cadence

‘ ® &0 L\ ‘ E" E e} S |[Design is:

E——

Placed 1
All Colors \

Physical View
Instance
Std. Cell
Physical Cell |
Cover Cell |
Block
P/G
Routing Blkg
Obstruct
Cell Blockage [] 1+
Instance Pin [ 1
Cell Layout [ 1
Standard Row [ @
5 Metal Fill  []w w
| Violation w
,,,,,, = Net Ow
| i Special Net L |
implant 0 7|
Implant 1 {
Bus Guide
Layers
Metal 0
Via 01
Metal 1
Via 12
Metal 2
Via 23

WHOEEEEE N<
LR R R R

N

]
L]
L

L

3257, -033

To solve these violations we edited the aspect ratio again from Floorplan ->

Specify Floorplan and the problem had been solved.
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SoC Encounter(TM) RTL-to-GDSII System 8.1 - /home/eslam/Desktop/test - count4

Design Edit Synthesis Partiion Floorplan Power Place Clock Route Timing 31 Verify Tools Help cadence
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Check the file named .checkPlace in your work directory to make sure that there

are no violations.

B count4.checkPlace [Read Only] (~/Desktop/test) ﬁdit
File Edit View Search Tools Documents Help

&3 open v =) B Y

count4.checkPlace ¢ |
1 ‘###############################################################

2 # Generated by: Cadence First Encounter 08.10-p004 1

3# 0S: Linux 1686(Host ID localhost.localdomain)
4 # Generated on: Fri Jul 11 16:59:46 2014

5# Command: checkPlace count4.checkPlace

O HARH R R R R R R R R R R R R R R R R R R AR R R R R AR R R R R R R R R R R R RN
7
8 ## No violations found ##

Plain Text v Tab Width: 8v Ln1,Coll INS

Now choose Timing -> Optimize to make the timing optimization for Pre-

CTS.
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Click OK in the following menu.

Optimization

Design Stage-
& Pre-CTS s Post-CTS . Post-Route

Optimization Type
W Setup o
- Incremental
4 Design Rules Violations
W Max Cap
| Max Tran

_| Max Fanout

Mode [ Default Close Help

Design Edit Synthesis Pariton Floorplan Power Place Clock Route Timing S| Verify Tools Help cadence
SR €4 ||Design is: Timing Analyzed W
|| g PY—e—
V8§
FPlan view w w |3
Module L
Fence LA
Guide L
Obstruct  [ljw W
Region L
Area Density W W
Instance  []@ W
Std. Cell  []w W
Cover Cell [ |@
o
o
ArealO Cell []@ W
Di |
Special Net W W
Terminal LI
Ruler L
Text -
Rel. FPlan -
vield Cell [
vield Map [
SDP Connect &
Density Map [
v
7
\\//
A
- / e
_‘ a | (  es2, 5838), |

Now choose Clock -> Design Clock then click Gen Spec and select your
CLKBUF cells.
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Syntﬁesize Clock Tree

Basic |

Clock Specification Files:
Results Directory: |clock_report

0K Apply Mode Load Spec Clear Spec Cancel Help | ’

Generate Clock Spec

—Specify Buffer/inverter

—Cells List —Selected Cells
BUFMER CKBUFM12R A
CKBUFM12R CKBUFM16R
CKBUFM1BR CKBUFMI1R
CKBUFM1R add CKBUFMZOR
CKBUFMZOR CKBUFMZ22RA
CKBUFMZZRA CKBUFMZ4R
CKBUFM24R CKBUFMZBRA
CKBUFMZERA CKBUFMZR
CKBUFMZR CKBUFM32ZR
CKBUFM32R CKBUFM3R
CKBUFM3R CKBUFM40R
CKBUFM40R CKBUFM4ER
CKBUFM48R CKBUFM4R
CKBUFM4R CKBUFMEBR
CKBUFMER Delete CKBUFMBR
CKBUFMER
CKINYM12R
CKINYM16R 1
CRINVRATR il

i | <] |
Output Specification File:|Clock.ctstch LI
oK Apply | Clear Spec Cancel Help
Then clock OK.

Now choose Clock -> Display -> Display Clock Tree. From the following
menu you can display the clock phase delay.
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= D'i'splay Clock Tﬁa

— Clock Selection

@ All Clock(s)
~ Selected Clock

— Route Selection

~~ Pre-Route
4% Clock Route Only
~~ Post-Route

— Display Selection
# Display Clock Tree
4 All Level
-~ Bottom Level (hon-gated clock tree only)
~ Selected Level (non-gated clock tree only)
|1
~~ Display Clock Phase Delay

~ Display Min/Max Paths

oK | Apply Cancel Help

Now choose Timing -> Optimize then select Post-CTS and click OK.

7c;ﬂmization

—Design Stage

~ Pre-CTS |0 POSI-CTSI ~ Post-Route

—Optimization Type
W Setup 1 Hold
~ Incremental
4 Design Rules Violations

W Max Cap

| Max Tran

_| Max Fanout

- _Siopors.|

oK Apply I Mode | Default l Close |

Help |

Open your terminal window and check the WNS field (Worst Negative Slack)

which means the slack of the critical path in your design.

Now choose Timing -> NanoRoute -> Route. From the following menu

check the required fields and click OK.
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NanoRoute

~Routing Phase

W Global Route
W Detail Route Start Iteration default End Iteration [default
|Post Route Optimization _j Optimize Via _{ Optimize Wire

—~Concurrent Routing Features —
W Fix Antenna _1 Insert Diodes

Cnngestion Timing
|| ™ Timing Driven Effort s | i SMART.
_1 Sl Driven
_{ Post Route SI | =]
_1 Litho Driven

_I Post Route Litho Repair

Routing Control

| Selected Nets Only Bottom Layer default Top Layer default

| ECO Route

_| Area Route I

~Job Control
W Auto Stop
Number of Thread(s) For Multiple Threaded:[1
Number of Thread(s) For Superthreaded:[T
Number of Host(s) For Superthreaded:[0

Set Multiple CPU... |

| OK | Apply l Anributel Maode | Save I Load I Qancel[ Help |‘

Next step is the post route timing optimization. Choose Timing -> Optimize

and choose Post-Route then OK.

7cgtimization

—Design Stage
~ Pre-CT3 ~ Post-CTS I L 2 Post—HouteI

—Optimization Type
W Setup
~ Incremental
4 Design Rules Violations
W Max Cap
| Max Tran
_| Max Fanout

_I Include 3l

oK Apply | Mode | Default Close | Help

1 Hold

Next step is to add filler cells. Choose Place -> Physical Cells -> Add Filler
and select filler cells from your technology library. Filler cells will fill remaining

holes in the rows and ensure the continuity of power/ground rails and N+/P+
wells.

The following steps are to check your design. To check connectivity, choose

Verify -> Verify Connectivity then press OK in the following window.
153



Verify Connectivity i’]

Net Type
4 All

~ Regular Only
~ Special Only

—HNets
4 Al

. Selected

~ Named:

—Check
W Open W UnConnected Pin ® Unrouted Net

1 Connectivity Loop @ Antenna W ‘Weakly Connected Pin
_| Geometry Loop _I Geometry Connectivity _{ Keep Previous Results

_1 Connect Pad Special Ports

Yerify Connectivity Report: |count4‘conn.rpt File
Report Limits
l?irror:hﬂl][] Warning: |50

Ok l Apply | Cancel | Help |

To check geometry of your design, choose Verify -> Verify Geometry then
click OK.

154



Verify Geometry =y

Basic

— Verification Area
@ Entire area

 Specify praw |
|0 0
10 |0
— Check

W Minimum Width & Minimum Spacing
| Minimum Area W Same Net Spacing
& Short _| Geometry Antenna
W Cell Overlap _1 Off Routing Grid
W Insufiicient Metal Overlap @ Off Manufacturing Grid
o MinHole W Implant Check
& Minimum Cut W MinStep

| Via Enclosure

—Allow
[ Pin In Blockage

Same Cell Violations

Different Cell Violations

Ovetrlap of Pad Filler Cells

Overlap of Routing Blockages And Pins

L L L L N

Overlap of Routing Blockage And Cell Blockage

Ok Apply Cancel Help

You can now generate some useful reports. Choose Design -> Report ->

Netlist Statistics and check your command window to see this report file.

You can also check the number of gates used in your design by choosing Design

-> Report -> Gate Count and click OK in the next window.
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# StdCells and Blocks
~ StdCellsOnly

To File |countd.gateCount k_}
% Design

~ Instance

OK | Cancel I Help

In command window, type report_timing to get a timing report for your design.

To export a standard delay format file type the following in command window

write_sdf countd4_clk10ns_pared.sdf -version 2.1

The P+R netlist may be different from the imported netlist as cells may have
been added or replaced during clock tree synthesis (CTS) and various timing
optimization phases. To export this netlist choose Design -> Save -> Netlist

and click OK in the following window.

W Include Intermediate Cell Definition

_1 Include Leaf Cell Definition

Netlist File:|countd.v n_|

QK | gancell Help |

The next step is to export this layout to a file which can be used in virtuoso
layout editot, choose Design -> Save -> GDS/OASIS. Choose an approptiate
Map File. The library name is the design library name in virtuoso. Choose
merge files and merge it with the .gds files from your technology library.
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GDS/OASIS g(port = i—'.

Output Format 4 GDSII/Stream ~ OASIS
Output File fcountd_clk10ns_pared.gds

_| Aftach Instance Name to Attribute Number |

_| Attach Net Name to Attribute Number |

Il Merge Files ]/gds/ukﬁS!scllmvbbr,gds H | Uniguify Cell Names
_1 Stripes |1
_| Write Die Area as Boundary

_1 Write abstract information for LEF Macros

Units 2000 _4|

Mode ALL — |

OK Apply Cancel | Help |

For more details please check this video:

http://voutu.be/udPMw9 Z1.0
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http://youtu.be/udPMw9_rZL0

Part 2:

The same steps of part 1 will be done here using this TCL script.

# Importing the Design

loadConfig Default.conf

setDrawView fplan

fit

saveDesign count4-import.enc

#Floorplanning the Design

floorPlan -r 1 0.85 0.6 0.6 0.6 0.6

saveDesign count4-fplan.enc

#Power Planning

clearGlobalNets

globalNetConnect VDD -type pgpin -pin VDD -inst * -module {} -verbose
globalNetConnect VSS -type pgpin -pin VSS -inst * -module {} -verbose
addRing \

-around core \

-nets {VSS VDD} \

-center 1\

-width_bottom 0.1 -width_right 0.1 -width_top 0.1 -width_left 0.1 \
-spacing_bottom 0.1 -spacing_right 0.1 -spacing_top 0.1 -spacing_left 0.1 \
-layer_bottom ME1 -layer_right ME2 -layer_top ME1 -layer_left ME2 \
-bl1-br1-rbO-rt0O-trO0-tI0O-lt1-b1l

#placing well taps

addWellTap -cell WT3R -maxGap 10 -skipRow 1 -startRowNum 2 -prefix WELLTAP
#special route

sroute \

-connect { blockPin corePin floatingStripe } \

-blockPin { onBoundary bottomBoundary rightBoundary } \
-allowJogging 1

saveDesign count4.enc

#Placing the standard cells

setPlaceMode -timingDriven true

placeDesign -prePlaceOpt

setDrawView place

checkPlace

optDesign -preCTS -outDir /home/eslam/Desktop/encounter
saveDesign count4-placed.enc

#Synthesizing a Clock Tree

createClockTreeSpec -output count4_spec.cts \
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-bufferList CKBUFM12R CKBUFM16R CKBUFM1R CKBUFM20R CKBUFM22RA CKBUFM24R
CKBUFM26RA CKBUFM2R CKBUFM32R CKBUFM3R CKBUFM40R \
CKBUFM48R CKBUFM4R CKBUFM6R CKBUFM8R CKINVM12R CKINVM16R CKINVM1R
CKINVM20R CKINVM22RA CKINVM24R CKINVM26RA \CKINVM2R CKINVM32R CKINVM3R
CKINVM40R CKINVM48R CKINVM4R CKINVM6R CKINVM8R
clockDesign -specFile pfd_loopF_spec.cts \
-outDir /home/eslam/Desktop/encounter

optDesign -postCTS -outDir /home/eslam/Desktop/encounter
saveDesign count4-cts.enc
#Routing the Design
setNanoRouteMode -routeWithTimingDriven true -routeTdrEffort 5
routeDesign
optDesign -postRoute -outDir /home/eslam/Desktop/encounter
saveDesign count4-routed.enc
#Design Finishing
addFiller \

-cell { FIL16R FIL1R FIL2R FIL32R FIL4R FIL64R FIL8R FILE16R FILE32R FILE3R FILE4R
FILE64R FILE6R \FILE8R FILEP16R FILEP32R FILEP64R FILEP8 } \

-prefix FIL
setDrawView place
saveDesign count4-filled.enc
#Checking the Design
verifyConnectivity -type all -report connectivity.rpt
verifyGeometry -report geometry.rpt
#Generating Reports
reportNetStat
reportGateCount -outfile gateCount.rpt
summaryReport -outdir /fhome/eslam/Desktop/encounter
#Design Export
write_sdf -version 2.1 -precision 4 count4_pared.sdf
saveNetlist -excludeLeafCell count4_pared.v
streamOut count4_pared.gds \
-mapFile streamOut_me_pinOnly.map \

-libName count4_pared \

-merge uk65Isclimvbbr.gds

For more details, please check the following video:

http://youtu.be/NEfx3igkzME
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http://youtu.be/NEfx3igkzME

Conclusion

Through this tutorial, we started with a gate level netlist (The file we got from
SYNOPSYS Design Vision) and followed all the steps to place and route the
standard cells in this netlist file. The final output from this tutorial is a layout file

and timing constraints files which can be used for post layout simulations.
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Appendix E

POWER CALCULATION

The method to measure power using Cadence Spectre is described in this tutorial,
the 2-bit inverter in the below figure is used as an example to show how power
measurement is done in cadence spectre .

The equations we need to apply to Calculate the average power consumed are :

The Instantaneous Power :
P (t) = Power supply voltage ( VDD ) * current drawn from
power supply at time

Then the Average Power

1

:Average Power = Time Period ITime Period Instantaneous Power

The following changes needs to be done for the measurement of the power drawn
from the power supply .

1. Changes to the Existing Schematic :

* On the top-level of the schematic, add a Vdc source (from the

analog library) and connect its positive terminal to the VDD.

* Select the Vdc source (a white box appears around the selected
item), and press Q, an edit object properties window will appear
Type he power supply value ( which is 3v in this example ) across

DC Voltage and press OK.

Important note :This addition of the Vdc source has to be done only to the top-
level of the design schematic and SHOULD NOT be done for each of the

blocks in the project.

Now, Save the sheet (check and save) and go to the analog-environment window

to perform the simulation.
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Figure 1

2. Simulation

" Make all the necessary set-up for the simulation

* To plot the current drawn from the VDD, select Output-> To Be
Plotted - > Select on Schematic in the analog-environment window
and then select the -ve terminal of the Vdc source in the schematic
( because the current plotted for a certain node is the input to this

node ).

* A circle appears in the schematic as shown in figure 2, make sure
the circle appears. If it does not appear, then you are plotting the

voltage and not the current.

Figure 2
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Simulate the circuit and the plot of the output current from the
VDD will be as shown in figure 3
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Select the tools -> calculator from the analog-environment window
To create TRAN current expression, check the (it) choice and then
reselect the -ve terminal of the Vdc source in the schematic, after
that select the function “INTEG” from the built-in functions.
Figure 4 clarify this step.
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The calculator window will appear as shown in figure 5 .This
simulation (for the 2-bit inverter) is done from On to 20ns. Let’s
find the average power consumed by this circuit in this period, thus
the integration should performed in this period (figure 5).In the
Signal text box, multiply the current waveform by 3 and divide by
20ns (figure 5).Press OK.
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Figure 5

The expression for power calculation appears in the result text-box.
Press “EVAL” from the keypad in the calculator. The average
power consumed by this circuit will be displayed in the result text-
box, as shown in figure 6.

Virtuoso (R) Visualization & Analysis XL calculator
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